
การใช้สถิติเพื่อการวิเคราะห์ข้อมูล 
 

หลังจากที่ได้เก็บหรือรวบรวมข้อมูลและด าเนินการจัดระเบียบข้อมูลให้อยู่ในสภาพที่
เรียบร้อยพร้อมที่จะน าไปวิเคราะห์ได้แล้ว งานในขั้นต่อไปของผู้วิจัยคือการตัดสินใจว่าจะน าสถิติอะไร
มาใช้ ซึ่งในการนี้ผู้วิจัยจะต้องทราบตั้งแต่แรกว่าข้อมูลที่มีอยู่ในลักษณะใดและต้องการเสนอผลการ
วิเคราะห์อะไร  
 ข้อมูลที่เก็บรวบรวมมาได้บางครั้งยังมีรูปแบบที่กระจัดกระจายเป็นรายบุคคล ไม่เป็นระบบ 
จ าเป็นต้องมีกระบวนการจัดกระท าข้อมูลเหล่านั้นให้เป็นระบบหรือเป็นหมวดหมู่เกิดเป็นสารสนเทศที่
สามารถน าไปใช้ประโยชน์ เพ่ือสรุปอ้างอิงไปยังประชากรต่อไป ศาสตร์ที่ถูกน าเข้ามาช่วยในขั้นตอน
ของการตรวจสอบคุณภาพของเครื่องมือไปจนถึงการอ้างอิงเหล่านี้ เรียกว่า สถิติ  
 
ความหมายของสถิติ 

ค าว่าสถิติ (Statistics) มาจากภาษาเยอรมันว่า Statistics มีรากศัพท์มาจาก Stat  หมายถึง    
ข้อมูลหรือสารสนเทศ ซึ่งจะอ านวยประโยชน์ต่อการบริหารประเทศในด้านต่างๆ เช่น การท า
ส ามะโนครัวเพ่ือจะทราบจ านวนพลเมืองในประเทศทั้งหมด ในสมัยต่อมา ค าว่า สถิติ ได้หมายถึง 
ตัวเลขหรือข้อมูลที่ได้จากการเก็บรวบรวม  เช่น จ านวนผู้ประสบอุบัติเหตุบนท้องถนน  อัตราการเกิด
ของเด็กทารก  ปริมาณน้ าฝนในแต่ละปี  เป็นต้น  สถิติในความหมายที่กล่าวมานี้เรียกอีกอย่างหนึ่งว่า  
ข้อมูลทางสถิต ิ(Statistical data)  

อีกความหมายหนึ่ง สถิติ  หมายถึง วิธีการที่ว่าด้วยการเก็บรวบรวมข้อมูล การน าเสนอ     
ข้อมูล  การวิเคราะห์ข้อมูล  และการตีความหมายข้อมูล  สถิติในความหมายนี้เป็นทั้งวิทยาศาสตร์
และศิลปศาสตร์ เรียกว่า สถิติศาสตร์ 
 
ประเภทของสถิติ 

สถิติแบ่งเป็น 2 ประเภท คือ 
1. สถิติพรรณนา (Descriptive Statistics)  

เป็นสถิติที่ใช้อธิบายคุณลักษณะของสิ่งที่ต้องการศึกษากลุ่มใดกลุ่มหนึ่ง ไม่สามารถ
อ้างอิงไปยังกลุ่มอ่ืนๆ ได้  สถิติที่อยู่ในประเภทนี้  เช่น  ค่าเฉลี่ย  ค่ามัธยฐาน  ค่าฐานนิยม          
ส่วนเบี่ยงเบนมาตรฐาน  ค่าพิสัย ฯลฯ 

2. สถิติอ้างอิง (Inferential statistics)  
เป็นสถิติที่ใช้อธิบายคุณลักษณะของสิ่งที่ต้องการศึกษากลุ่มใดกลุ่มหนึ่งหรือหลายกลุ่ม  

แล้วสามารถอ้างอิงไปยังกลุ่มประชากรได้  โดยกลุ่มที่น ามาศึกษาจะต้องเป็นตัวแทนที่ดีของประชากร  
ตัวแทนที่ดีของประชากรได้มาโดยวิธีการสุ่มตัวอย่าง  และตัวแทนที่ดีของประชากรเรียกว่า  กลุ่ม
ตัวอย่าง  สถิติอ้างอิงแบ่งได้เป็น 2 ประเภท คือ 
  2.1 สถิติพารามิเตอร์ (Parametric Statistics ) เป็นวิธีการทางสถิติที่จะต้องเป็นไป
ตามข้อตกลงเบื้องต้น  3  ประการ  ดังนี้ 

(1) ข้อมูลที่เก็บรวบรวมได้จะต้องอยู่ในระดับช่วงขึ้นไป (Interval Scale) 
(2) ข้อมูลที่เก็บรวบรวมได้จากกลุ่มตัวอย่างจะต้องมีการแจกแจงเป็นโค้งปกติ 
(3) กลุ่มประชากรแต่ละกลุ่มท่ีน ามาศึกษาจะต้องมีความแปรปรวนเท่ากัน 
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สถิติที่อยู่ในประเภทนี้  เช่น  t-test,  Z-test,  ANOVA,  Regression  ฯลฯ 
  2.2 สถิตไร้พารามิเตอร์ (Nonparametric Statistics) เป็นวิธีการทางสถิติที่
สามารถน ามาใช้ได้โดยปราศจากข้อตกลงเบื้องต้นทั้ง 3 ประการข้างต้น  สถิติที่อยู่ในประเภทนี้ เช่น       
ไคสแควร์,  Median Test,  Sign test  ฯลฯ 
 
แนวความคิดพื้นฐานทางสถิตอ้ิางอิง 
 ในการเก็บรวบรวมข้อมูลการวิจัยสิ่งแรกที่นักวิจัยจะต้องก าหนดคือ ประชากรที่ต้องการ
ศึกษา จากนั้นนักวิจัยต้องพิจารณาต่อไปว่าสามารถรวบรวมข้อมูลจากประชากรทั้งหมดหรือไม่ ถ้า
ไม่ได้ก็ต้องท าการศึกษาเพียงบางส่วนของประชากรเท่านั้น การที่ประชากรที่นักวิจัยสนใจมีขนาดใหญ่
คือมีจ านวนมากไม่สามารถศึกษาทุกหน่วยของประชากรได้และจะต้องเป็นเหตุให้ต้องเลือกกลุ่ม
ตัวแทนของประชากรมาใช้ในการศึกษา ซึ่งเราเรียกกันโดยทั่วไปว่า กลุ่มตัวอย่าง โดยที่ค่าต่างๆ ที่
ค านวณไดจ้ึงมีชื่อเรียกตามกลุ่มตัวอย่างและประชากรที่ใช้ในการศึกษา แบ่งออกเป็น 2 ชนิด คือ 
 1. พารามิเตอร์ (Parameter) คือ ค่าต่างๆ ที่รวบรวมมาจากประชากรหรือค านวณได้จาก
ประชากร ใช้อักษรกรีกเป็นสัญลักษณ์ ได้แก่ 

 แทนค่า ค่าเฉลี่ยเลขคณิต 
 แทนค่า ส่วนเบี่ยงเบนมาตรฐาน 


2 แทนค่า ความแปรปรวน 
 แทนค่า สัมประสิทธิ์สหสัมพันธ์ 
 
 

2. ค่าสถิติ (Statistic) คือค่าต่างๆ ที่รวบรวมมาจากกลุ่มตัวอย่างหรือค านวณได้จากกลุ่ม
ตัวอย่าง ใช้ตัวภาษาอังกฤษเป็นสัญลักษณ์ ได้แก่ 

x  แทนค่า ค่าเฉลี่ยเลขคณิต 
s แทนค่า ส่วนเบี่ยงเบนมาตรฐาน 
s2 แทนค่า ความแปรปรวน 
r แทนค่า สัมประสิทธิ์สหสัมพันธ์ 

 
แนวคิดพ้ืนฐานของการวิเคราะห์ข้อมูลทางสถิติ 
 
 การสุ่มตัวอย่าง 
 
 
 
 
  
 
 
 

ประชากร 
(population) 
ขนาด N 

กลุ่มตวัอยา่ง 
(sample) 
ขนาด n 

ค่าสถิติ 
(statistic) 

ค่าพารามิเตอร์ 
(parameter) 

อ้างองิ 
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สิ่งท่ีต้องพิจารณาในการเลือกใช้ชนิดทางสถิติ 
 ในการพิจารณาในการเลือกใช้ชนิดทางสถิตินั้น จะต้องมีการค านึงถึงจุดมุ่งหมายหรือ
วัตถุประสงค์ของการวิจัย ซึ่งโดยทั่วไปแบ่งจุดมุ่งหมายหรือวัตถุประสงค์ของการวิจัยได้ดังต่อไปนี้ 

 1.เพ่ือบรรยายลักษณะตัวแปรในกลุ่มตัวอย่างหรือประชากร เป็นการใช้สถิติบรรยาย 
มาบรรยายภาพรวมของกลุ่มตัวอย่าง ประกอบด้วย 

- การแจกแจงความถี่และค่าร้อยละ และน าผลจากการแจกแจงความถี่
หรือค่าร้อยละเพ่ือแสดงภาพรวมของข้อมูลที่ได้ ในการน าเสนอนิยมใช้
ตารางและแผนภูมิมากกว่าค าบรรยายเพียงอย่างเดียว 

- การวัดแนวโน้มเข้าสู่ส่วนกลาง ได้แก่ ค่าเฉลี่ยเลขคณิต มัธยฐาน ฐาน
นิยม 

- การวัดการกระจาย ได้แก่ ส่วนเบี่ยงเบนมาตรฐาน  
 

2. เพ่ือเปรียบเทียบหาความแตกต่าง และสรุปอ้างอิงหาความแตกต่างจากกลุ่ม
ตัวอย่างกลับไปยังประชากรที่ศึกษา ได้แก่ 

- การเปรียบเทียบค่าเฉลี่ยของกลุ่มตัวอย่าง 2 กลุ่มที่เป็นอิสระกันด้วย  
Independent t-test  

- การเปรียบเทียบค่าเฉลี่ยของกลุ่มตัวอย่าง 2 กลุ่มที่ไม่เป็นอิสระต่อกัน
ด้วย  pair t-test  

- การเปรียบเทียบค่าเฉลี่ยของกลุ่มตัวอย่างตั้งแต่ 2 กลุ่มด้วย Anova 
- การเปรียบเทียบความถ่ีและสัดส่วนด้วยไคสแควร์ 

3. เพ่ือบรรยายความสัมพันธ์ระหว่างตัวแปร ได้แก่ การใช้สหสัมพันธ์อย่างง่าย ใน
การบรรยายความสัมพันธ์ระหว่าง 2 ตัวแปร เช่น การวิเคราะห์ค่าสหสัมพันธ์แบบเพียร์สัน 
(Pearson’s product moment coefficient of correlation) และสหสัมพันธ์แบบสเปียร์แมน 
(Spearman’s Correlation) และการใช้สหสัมพันธ์พหุคูณ ในการบรรยายความสัมพันธ์ระหว่างตัว
แปรตั้งแต่ 2 ตัวขึ้นไป 
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การทดสอบสมมติฐาน (Hypothesis testing) 
 

สมมติฐาน ( Hypothesis ) มี 2 ชนิด คือ สมมติฐานทางการวิจัย (Research hypothesis) 
กับสมมติฐานทางสถิติ (Statistical hypothesis) การวิจัยบางเรื่องอาจไม่มีสมมติฐานการวิจัยก็ได้ 
ส่วนที่ มีสมมติฐานมักเป็นการหาความสัมพันธ์ระหว่างตัวแปร เช่น ศึกษาความสัมพันธ์ระหว่างความ
ถนัดทางการเรียนกับผลสัมฤทธิ์ทางการเรียน เป็นต้น  หรือเป็นการวิจัยที่อยู่ในลักษณะที่เป็นการ
เปรียบเทียบ เช่น ความมีวินัยในตนเองระหว่างนักเรียนที่ได้รับการอบรมเลี้ยงดูด้วยวิธีต่างกัน 
 กระบวนการทดสอบสมมติฐาน จะช่วยผู้วิจัยในการตัดสินใจสรุปผลว่ามีความสัมพันธ์กัน
ระหว่างตัวแปรจริงหรือไม่ หรือช่วยใจการตัดสินใจเพ่ือสรุปผลว่าสิ่งที่น ามาเปรียบเทียบกันนั้น
แตกต่างกันจริงหรือไม่  ส าหรับหัวข้อส าคัญที่จะกล่าวถึงคือ ความหมายของสมมติฐาน ประเภทของ
สมมติฐาน ขั้นตอนการทดสอบสมมุติฐาน ชนิดของความคลาดเคลื่อน ระดับนัยส าคัญ และการ
ทดสอบสมมุติฐานแบบมีทิศทางและแบบไม่มีทิศทาง 
 
ความหมายของสมมุติฐาน 
 สมมุติฐาน คือ ค าตอบที่ผู้วิจัยคาดคะเนไว้ล่วงหน้าอย่างมีเหตุผล หรือสมมุติฐานคือข้อความ
ที่อยู่ในรูปของการคาดคะเนความสัมพันธ์ระหว่างตัวแปร 2 ตัว หรือมากกว่า 2 ตัวเพ่ือใช้ตอบปัญหา
ที่ต้องการศกึษา สมมุติติฐานที่ดีมีหลักเกณฑ์ที่ส าคัญ 2 ประการคือ 

1. เป็นข้อความที่กล่าวถึงความสัมพันธ์ระหว่างตัวแปร 
2.เป็นสมมุติฐานที่สามารถทดสอบได้โดยวิธีการทางสถิติ 

 
ประเภทของสมมุติฐาน  สมมุติฐานมี 2 ประเภท คือ  

1. สมมุติฐานทางการวิจัย (Research hypothesis) เป็นค าตอบที่ผู้วิจัยคาดคะเนไว้
ล่วงหน้า และเป็นข้อความที่แสดงความเก่ียวข้องระหว่างตัวแปร ตัวอย่างเช่น  

ตัวอย่างที่ 1 นักเรียนในกรุงเทพฯจะมีทัศนะคติทางวิทยาศาสตร์ดีกว่านักเรียนใน
ชนบท 

ตัวอย่างท่ี 2 ผลการเรียนรู้ก่อนเข้าค่ายของนักศึกษาน้อยกว่าผลการเรียนรู้หลังเข้า
ค่ายของนักศึกษา 

ตัวอย่างที่ 3 นักเรียนที่ได้รับการอบรมเลี้ยงดูด้วยวิธีการต่างกันจะมีวินัยในตนเอง
ต่างกัน 

ตัวอย่างที่ 4 ความถนัดทางการเรียนมีความสัมพันธ์ทางบวกกับผลสัมฤทธิ์ทางการ
เรียน 

สมมุติฐานดังกล่าวเป็นเพียงการคาดคะเน ยังไม่เป็นความรู้ที่เชื่อถือได้ จนกว่าจะ 
ได้รับการทดสอบโดยใช้วิธีการทางสถิติ 

ตัวอย่างที่ 1 มีตัวแปรที่เกี่ยวข้อง 2 ตัว คือ 1) ภูมิล าเนาของนักเรียน 2) ทัศนะคติ
ทางวิทยาศาสตร์ 

ตัวอย่างท่ี 2 มีตัวแปรที่เกี่ยวข้อง 2 ตัวคือ 1) ผลการเรียนรู้ก่อนเข้าค่าย 2) ผลการ
เรียนรู้หลังเข้าค่าย 

ตัวอย่างท่ี 3 มีตัวแปรที่เกี่ยวข้อง 2 ตัว คือ 1) วิธีการอบรมเลี้ยงดู 2) วินัยในตนเอง 
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ตัวอย่างที่ 4 มีตัวแปรที่เกี่ยวข้อง 2 ตัว คือ 1) ความถนัดทางการเรียน และ  2) 
ผลสัมฤทธิ์ทางการเรียน 
 

สมมุติฐานทางการวิจัย มี 2 ชนิดคือ 
1. สมมุติฐานทางการวิจัยมีแบบมีทิศทาง (Directional hypothesis) เป็น

สมมุติฐานที่เขียนระบุอย่างชัดเจนถึงทิศทางของความแตกต่างถึงทิศทางของความแตกต่างระหว่าง
กลุ่ม โดยมีค าว่า   “ ดีกว่า ” หรือ  “ สูงกว่า ” หรือ “ ต่่ากว่า ” หรือ “ น้อยกว่า” ในสมมุติฐาน
นั้นๆ ดังตัวอย่างที่ 1 และที่ 2 ข้างต้น หรือระบุทิศทางของความสัมพันธ์ โดยมีค าว่า “ ทางบวก ” 
หรือ “ทางลบ ” ดังตัวอย่างที่ 4 ข้างต้น ยกตัวอย่างเช่น  
  - ผู้บริหารเพศชายมีประสิทธิภาพในการบริหารงานมากกว่าผู้บริหารเพศหญิง 
  - ผู้บริหารชายมีการใช้อ านาจในต าแหน่งมากกว่าผู้บริหารหญิง 
  - ครูอาจารย์เพศชายมีความวิตกกังวลในการท างานน้อยกว่าครูอาจารย์เพศหญิง 
  - เจตคติต่อวิชาวิจัยทางการศึกษามีความสัมพันธ์ทางบวกกับผลสัมฤทธิ์ทางการ
เรียนวิชาวิจัยทางการศึกษา 
  2. สมมุติฐานทางการวิจัยไม่มีแบบไม่มีทิศทาง (Non-directional hypothesis ) 
เป็นสมมุติฐานที่ไม่ก าหนดทิศทางของความแตกต่างดังตัวอย่างที่ 3 หรือไม่ก าหนดทิศทางของ
ความสัมพันธ์  ดังตัวอย่าง 

- นักเรียนที่มีเพศต่างกันมีเจตคติต่อวิชาคณิตศาสตร์แตกต่างกัน 
    - ผู้บริหารที่มีเพศต่างกันมีปัญหาในการบริหารงานวิชาการแตกต่างกัน 

- ภาวะผู้ของผู้บริหารมีความสัมพันธ์กับบรรยากาศองค์การ 
 

 
 

2. สมมุติฐานทางสถิติ (Statistical hypothesis) เป็นสมมุติฐานที่ตั้งขึ้นเพ่ือใช้ทดสอบว่า 
สมมุติฐานทางการวิจัยที่ผู้วิจัยตั้งไว้เป็นจริงหรือไม่ เป็นสมมุติฐานที่เขียนอยู่ในรูปแบบของโครงสร้าง
ทางคณิตศาสตร์ เพ่ือให้อยู่ในรูปที่สามารถทดสอบได้ด้วยวิธีการทางสถิติ สัญลักษณ์ที่ใช้เขียนใน
สมมตุิฐานทางสถิติจะเป็นพารามิเตอร์เสมอ ที่พบบ่อยๆได้แก่  

  (อ่านว่า  มิว) แทนตัวกลางเลขคณิตหรือค่าเฉลี่ยของกลุ่มประชากร 
 ( อ่านว่า  โร ) แทนสหสัมพันธ์ระหว่างตัวแปร  
 ( อ่านว่า ซิกมา ) แทนความเบี่ยงเบนมาตรฐานของกลุ่มประชากร 

 
สมมุติฐานทางสถิติ มี 2 ชนิดคือ 
2.1 สมมุติฐานที่เป็นกลางหรือสมมุติฐานที่ไร้นัยส าคัญ (Null hypothesis) สัญลักษณ์ที่ใช้ 

คือ H0  
2.2 สมมุติฐานทางเลือก (Alternative hypothesis) สัญลักษณ์ท่ีใช้ คือ  H1  

 ในการวิจัยหลังจากท่ีตั้งความมุ่งหมายของการวิจัยแล้ว ผู้วิจัยมักจะตั้งสมมุติฐานทางการวิจัย
เพ่ือคาดคะเนค าตอบไว้ล่วงหน้า แล้วจึงเก็บรวบรวม ข้อมูลเพ่ือท าการทดสอบสมมุติฐานทางการวิจัย
ที่ตั้งไว้ โดยจะต้องแปลงสมมุติฐานทางการวิจัยให้เป็นสมมุติฐานทางสถิติก่อน จึงจะทดสอบได้ด้วย
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วิธีการทางสถิติเวลาตั้งสมมุติฐานทางสถิติจะต้องตั้งทั้ง Null hypothesis และ Alternative 
hypothesis  
 สมมุติฐานไร้นัยส าคัญ แทนด้วย H0 เป็นสมมุติฐานที่แสดงให้เห็นว่าไม่มีความแตกต่าง
ระหว่างกลุ่มหรือไม่มีความสัมพันธ์ระหว่างตัวแปร เช่น 
  H0     : 1   =   2  

หมายความว่าค่าเฉลี่ยของกลุ่มประชากรกลุ่มที่ 1 และกลุ่มที่ 2 เท่ากันหรือไม่มีความ
แตกต่างกัน 

หรือ H0     : ก่อน  =   หลงั  

หมายความว่าค่าเฉลี่ยของกลุ่มประชากรก่อนและหลังการทดลองเท่ากันหรือไม่มีความ
แตกต่างกัน 

หรือ H0     : 1   =   2   =  3  

หมายความว่าค่าเฉลี่ยของกลุ่มประชากรกลุ่มที่ 1 และกลุ่มที่ 2 และกลุ่มที่ 3 เท่ากันหรือไม่
มีความแตกต่างกัน 
 หรือ H0     :      =    0 

หมายความว่าไม่มีความสัมพันธ์ระหว่างตัวแปร X กับตัวแปร Y  
 

สมมุติฐานทางเลือก แทนด้วย  H1    เป็นสมมุติฐานที่แสดงให้เห็นว่ามีความแตกต่างระหว่าง
กลุ่มหรือมีความสัมพันธ์ระหว่างตัวแปร เช่น    
  H1     : 1       2  

หมายความว่าค่าเฉลี่ยของกลุ่มประชากร กลุ่มที่ 1 และกลุ่มที่ 2 ไม่เท่ากันหรือมีความ
แตกต่างกัน 

หรือ H1     : ก่อน      หลงั  

หมายความว่าค่าเฉลี่ยของกลุ่มประชากรก่อนและหลังการทดลองไม่เท่ากันหรือมีความ
แตกต่างกัน 

หรือ H1     : 1      2      3  หรือ มีค่า  อย่างน้อย 1 คู่ที่ไม่เท่ากัน 

หมายความว่าค่าเฉลี่ยของกลุ่มประชากรกลุ่มที่ 1 และกลุ่มที่ 2 และกลุ่มที่ 3 ไม่เท่ากันหรือ
มีความแตกต่างกัน 

หรือ H1      :         0 
 หมายความว่ามีความสัมพันธ์ระหว่างตัวแปร  
 

การตั้งสมมุติฐาน กรณีท่ีเป็นงานวิจัยในลักษณะเปรียบเทียบ   จะมีได้   3  ลักษณะ ดังนี้ 
 H0     : 1   =   2  (เท่ากันหรือไม่แตกต่างกัน) 

H1     :  1     2   (ไม่เท่ากันหรือต่างกัน) 

H0     : 1   =   2  (เท่ากันหรือไม่แตกต่างกัน) 

     H1     :  1      2  (มากกว่า) 
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H0     : 1   =   2  (เท่ากันหรือไม่แตกต่างกัน) 

 H1     :  1    <  2   (น้อยกว่า) 

 
ในกรณีที่เป็นงานวิจัยที่ศึกษาความสัมพันธ์ระหว่างตัวแปร H1  มีได้ 3 ลักษณะดังนี้  
H0  :    =  0 (ไม่มีความสัมพันธ์กัน) 
H1   :  0  (มีความสัมพันธ์กัน) 

     H0  :    = 0 (ไม่มีความสัมพันธ์กัน) 
H1   :  0  (มีควาสัมพันธ์เชิงบวก) 

 H0  :    = 0 (ไม่มีความสัมพันธ์กัน) 
H1   :  0  (มีควาสัมพันธ์เชิงลบ) 

  
ข้อสังเกต รูปแบบในการเขียนสมมุติฐานทางสถิติแต่ละครั้งจะต้องเขียนให้สอดคล้องกับ

สมมุติฐานทางการวิจัยซึ่งอาจเขียนได้แตกต่างกัน และเพ่ือที่จะสามารถเลือกใช้สถิติที่จะท าการ
ทดสอบได้อย่างถูกต้องตรงตามสมมุติฐานที่ตั้งไว้ 

 
ยกตัวอย่าง เช่น 

ตัวอย่างท่ี 1 นักเรียนในกรุงเทพฯจะมีทัศนะคติทางวิทยาศาสตร์ดีกว่านักเรียนในชนบท 
จากตัวอย่างที่ 1 มีตัวแปรที่เกี่ยวข้อง 2 ตัว คือ 1) ภูมิล าเนาของนักเรียน (กรุงเทพฯ และ

ชนบท) 2) ทัศนะคติทางวิทยาศาสตร์ (วัดออกมาเป็นตัวเลข) 
 การตั้งสมมุติฐาน H0     : 1   =   2  

   H1     :  1     2  

 โดยที่  1 คือ ค่าเฉลี่ยของทัศนะคติทางวิทยาศาสตร์ของนักเรียนในกรุงเทพ 

  2 คือ ค่าเฉลี่ยของทัศนะคติทางวิทยาศาสตร์ของนักเรียนในชนบท 

 สถิติที่จะใช้ในการทดสอบ คือ Independent t-test 
 
 ตัวอย่างท่ี 2 ผลการเรียนรู้ก่อนเข้าค่ายของนักศึกษาน้อยกว่าผลการเรียนรู้หลังเข้าค่ายของ
นักศึกษา 

จากตัวอย่างท่ี 2 มีตัวแปรที่เกี่ยวข้อง 2 ตัวคือ 1) ผลการเรียนรู้ก่อนเข้าค่าย (วัดออกมาเป็น
ตัวเลข) 2) ผลการเรียนรู้หลังเข้าค่าย (วัดออกมาเป็นตัวเลข) 

การตั้งสมมุติฐาน H0     : ก่อน    =   หลงั  

   H1     :  ก่อน  <   หลงั  

 โดยที่  ก่อนคือ ค่าเฉลี่ยของผลการเรียนรู้ก่อนเข้าค่ายของนักศึกษา 
หลงัคือ ค่าเฉลี่ยของผลการเรียนรู้หลังเข้าค่ายของนักศึกษา 

 สถิติที่จะใช้ในการทดสอบ คือ Pair t-test 
 



  

 

8 

 
ตัวอย่างท่ี 3 นักเรียนที่ได้รับการอบรมเลี้ยงดูด้วยวิธีการต่างกันจะมีวินัยในตนเองต่างกัน 
จากตัวอย่างที่ 3 มีตัวแปรที่เกี่ยวข้อง 2 ตัว คือ 1) วิธีการอบรมเลี้ยงดู (มีหลายวิธี) 2) วินัย

ในตนเอง (วัดออกมาเป็นตัวเลข) 
การตั้งสมมุติฐาน H0     : 1   =   2   =  3  

   H1     : 1      2      3   

หรือ มีค่า  อย่างน้อย 1 คู่ที่ไม่เท่ากัน 

 โดยที่  1 คือ ค่าเฉลี่ยของวินัยในตนเองของนักเรียนที่ได้รับการอบรมเลี้ยงดูด้วยวิธีที่ 1 

  2 คือ ค่าเฉลี่ยของวินัยในตนเองของนักเรียนที่ได้รับการอบรมเลี้ยงดูด้วยวิธีที่ 2 
3คือ ค่าเฉลี่ยของวินัยในตนเองของนักเรียนที่ได้รับการอบรมเลี้ยงดูด้วยวิธีที่ 3 

 สถิติที่จะใช้ในการทดสอบ คือ ANOVA 
 
ตัวอย่างท่ี 4 ความถนัดทางการเรียนมีความสัมพันธ์ทางบวกกับผลสัมฤทธิ์ทางการเรียน 

 จากตัวอย่างที่ 4 มีตัวแปรที่เกี่ยวข้อง 2 ตัว คือ 1) ความถนัดทางการเรียน (วัดออกมาเป็น
ตัวเลข) และ  2) ผลสัมฤทธิ์ทางการเรียน (วัดออกมาเป็นตัวเลข) 
 การตั้งสมมุติฐาน H0     :     =   0 

H1      :     >   0 
 โดยที่   คือ ความสัมพันธ์ระหว่างความถนัดทางการเรียนกับผลสัมฤทธิ์ทางการเรียน 
 สถิติที่จะใช้ในการทดสอบ คือ ค่าสหสัมพันธ์แบบเพียร์สัน 
 
ขั้นตอนการทดสอบสมมุติฐาน  
 1. การทดสอบสมมุติฐานมีขั้นตอนดังนี้ (ค่านวณด้วยมือ) 
ขั้นที่ 1 ต้ังสมมุติฐานทางสถิต ิ
ขั้นที่ 2 ก าหนดระดับนัยส าคัญทางสถิติ(ก าหนด  ) และหาอาณาเขตวิกฤตหรืออาณาเขตที่จะ    
ปฎิเศษ H0  (ได้จากตารางสถิติ) 

2.1 การทดสอบแบบมีทิศทาง หรือบางทีเรียกว่า การทดสอบแบบหางเดียว ( One- tailed 
test ) มี 2 กรณี คือ  

 
  กรณีหางเดียวทางขวา H1     : 1   >   2  

 
       ยอมรับ   oH                                                ปฎิเสธ  oH     
 
 
                                                                                              
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  กรณีหางเดียวทางซ้าย H1     : 1   <   2  

 
ปฎิเสธ  oH                                                  ยอมรับ   oH  
              
             
                                                                                                                                
 
 

2.2 แบบไม่มีทิศทาง หรือการทดสอบแบบสองหาง ( Two - tailed test ) ซึ่งเป็นการ
ทดสอบเม่ือ H1     : 1       2  

                                                ยอมรับ oH     
ปฎิเสธ  oH                                                                       ปฎิเสธ  oH                                                                  
                                                         
 

           
2

                                                                                     
2

   

 
 
ขั้นที่ 3 ค านวณค่าสถิติที่ใช้ทดสอบสมมุติฐาน 
ขั้นที่ 4 น าค่าสถิติทีไ่ด้ไปเปรียบเทียบกับค่าวิกฤตที่ได้จากตารางสถิติ  
ขั้นที่ 5 การตัดสินใจ มี 2 กรณี 

1. ถ้าค่าที่ค านวณได้ตกอยู่ในอาณาเขตวิกฤตจะปฏิเสธ (reject) H0 ยอมรับ (accept) H1    
2. ถ้าค่าสถิติที่ค านวณได้อยู่นอกอาณาเขตวิกฤตยอมรับ H0     

  
 2. การทดสอบสมมุติฐานด้วยโปรแกรมคอมพิวเตอร์ 
ขั้นที่ 1 ตั้งสมมุตฐิานทางสถิติ 
ขั้นที่ 2 ก าหนดระดับนัยส าคัญทางสถิติ (ก าหนด  ) และหาอาณาเขตวิกฤต (อาณาเขตที่จะปฎิเศษ 
H0 ) 

2.1 การทดสอบแบบมีทิศทาง หรือบางทีเรียกว่า การทดสอบแบบหางเดียว ( One- tailed 
test ) มี 2 กรณี คือ  
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  กรณหีางเดียวทางขวา H1     : 1   >   2  

 
       ยอมรับ   oH                                                ปฎิเสธ  oH     
 
 
                                                                                              
 
 
  กรณีหางเดียวทางซ้าย H1     : 1   <   2  

 
ปฎิเสธ  oH                                                  ยอมรับ   oH  
              
             
                                                                                                                                
 
 

2.2 แบบไม่มีทิศทาง หรือการทดสอบแบบสองหาง ( Two - tailed test ) ซึ่งเป็นการ
ทดสอบเม่ือ H1     : 1       2  

                                                ยอมรับ oH     
ปฎิเสธ  oH                                                                       ปฎิเสธ  oH                                                                  
                                                         
 

           
2

                                                                                     
2

   

 
 
ขั้นที่ 3 ค านวณค่าสถิติที่ใช้ทดสอบสมมุติฐานทางคอมพิวเตอร์ 
ขั้นที่ 4 น าค่าสถิติที่ได้จากคอมพิวเตอร์ (Sig.)ไปเปรียบเทียบกับค่าวิกฤต 
ขั้นที่ 5 การตัดสินใจ มี 2 กรณี 
 กรณีท่ี 1 กรณีสองหาง สรุปผลดังนี้   

1. ถ้าค่า Sig. <  จะปฏิเสธ (reject) H0 ยอมรับ (accept) H1    
2. ถ้าค่า Sig. >  จะยอมรับ H0     

 กรณีท่ี 2 กรณีหางเดียวทางขวาและกรณีหางเดียวทางซ้าย สรุปผลดังนี้   
1. ถ้าค่า Sig./2 <  จะปฏิเสธ (reject) H0 ยอมรับ (accept) H1    
2. ถ้าค่า Sig./2  >  จะยอมรับ H0     

 
การประมวลผลข้อมูลด้วยคอมพิวเตอร์ : โปรแกรม SPSS for Windows 
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 การประมวลผลข้อมูลเป็นการจัดการกับข้อมูลอย่างมีระบบ เพ่ือให้ขอมูลที่ได้รับการ
ประมวลผลแล้วอยู่ในรูปที่สามารถน าไปใช้งานได้อย่างมีประสิทธิภาพ  ซึ่งมีขั้นตอน ดังนี้ 
 1 การเก็บรวบรวมข้อมูล เป็นการเก็บรวบรวมข้อมูลที่ได้จากรูปแบบต่างๆ เช่นแบบสอบถาม 
แบบทดสอบ แบบสัมภาษณ์ ทั้งท่ีเป็นข้อมูลปฐมภูมิและทุติยภูมิ 
 2. การเปลี่ยนสภาพข้อมูล เป็นการเปลี่ยนสภาพของข้อมูลที่เก็บรวบรวมมาได้ให้อยู่ใน
รูปแบบที่สะดวกหรือเหมาะสมต่อการน าไปประมวลผล ซึ่งประกอบด้วย 
  2.1 การลงรหัส (Coding) เป็นการเปลี่ยนรูปแบบข้อมูลโดยให้รหัสแทนข้อมูลเพ่ือ
ท าให้สามารถจ าแนกลักษณะข้อมูล รหัสที่ใช้แทนข้อมูลอาจจะอยู่ในรูปตัวเลข ตัวอักษร หรือข้อความ 
ซึ่งโดยปกตินิยมก าหนดรหัสข้อมูลให้เป็นตัวเลข (ยกเว้นโปรแกรมที่ใช้ประมวลผลข้อมูลในการวิจัยเชิง
คุณภาพโดยเฉพาะ) ไม่ว่าจะเป็นข้อมูลเชิงคุณภาพหรือเชิงปริมาณ แต่การน าไปวิเคราะห์หรือ
ประมวลผล และการตีความจะแตกต่างกันไป  
  2.2 การแก้ไข (Editing) เป็นการตรวจสอบความถูกต้องของข้อมูลรวมทั้งข้อมูลที่ได้
แปลงให้อยู่ในรูปรหัสแล้ว รวมทั้งการตรวจสอบความสมบูรณ์ของข้อมูล และแก้ไขปรับปรุงให้ถูกต้อง 
 3.  การประมวลผล (Data processing) เป็นการน าข้อมูลที่ได้จากการเปลี่ยนสภาพแล้ว มา
ท าการวิเคราะห์ข้อมูล ซึ่งในปัจจุบันจะใช้โปรแกรมส าเร็จรูปทางสถิติช่วยในการวิเคราะห์ ซึ่งการ
วิเคราะห์ อาจจะเป็นการวิเคราะห์ขั้นต้น เช่น การเรียงล าดับ  (Sorting) การรวบรวมข้อมูล 
(Merging) หรือการวิเคราะห์ในระดับที่สูงขึ้นมาอีก เช่น การประมาณค่า (Estimate) การทดสอบ
สมมติฐาน (Hypothesis testing)  หรือการวิเคราะห์โดยใช้สถิติชั้นสูงอ่ืนๆ 
 4. การแสดงผลลัพธ์ (Output) เป็นการน าเสนอผลลัพธ์จากการวิเคราะห์ข้อมูลให้อยู่ในรูปที่
เข้าใจง่าย ซึ่งอาจเป็นรายงาน ตาราง กราฟ หรือแผนภูมิอ่ืนๆ 
 
การสร้างรหัสส่าหรับตัวแปร 
 โดยปกติในการวิจัย ผู้วิจัยจะออกแบบการวิจัยโดยก าหนดตัวแปรไว้ตั้งแต่ก่อนการเก็บ
รวบรวมข้อมูลแต่ถ้าเป็นข้อมูลที่มีการรวบรวมเพ่ือประมวลผลเพ่ือวัตถุประสงค์ใดประสงค์หนึ่งอาจ
ไม่ได้ก าหนดตัวแปรไว้ล่วงหน้าก็ได้ ดังนั้นเมื่อมีการเก็บรวบรวมข้อมูลแล้ว จะต้องก่าหนดตัวแปรหรือ
ค่ารหัสของตัวแปร การก าหนดชื่อตัวแปรนั้นจะต้องก าหนดทั้งข้อมูลที่เป็นเชิงคุณภาพและเชิง
ปริมาณ ส่วนการให้ค่ารหัสนั้นมักจะใช้กับตัวแปรเชิงคุณภาพ เช่น เพศ อาชีพ ศาสนา วุฒิการศึกษา 
เป็นต้น ส่วนตัวแปรเชิงปริมาณก็ใช้ค่าที่ได้จากการเก็บรวบข้อมูลจริง เช่น อายุ ก็จะใส่ค่ารหัส ตาม
อายุจริงที่ได้จากการเก็บรวบรวมข้อมูลมา ยกเว้น แต่มีการก าหนดช่วงอายุหรือจัดกลุ่มอายุไว้ตั้งแต่
ก่อนการเก็บข้อมลู ในลักษณะอย่างนี้จ าเป็นต้องก าหนดค่ารหัสเช่นกัน 
 ในบางครั้งการก าหนดตัวแปรหรือก าหนดรหัสจะท าควบคู่กับเครื่องมือการวิจัย ซึ่งค าถาม 1 
ค าถาม จะสามารถสร้างตัวแปรได้อย่างน้อย 1 ตัวแปร และค่าของตัวแปรที่ได้ก็คือข้อมูลนั่นเอง 
สามารถแสดงตัวอย่างการก าหนดตัวแปรและการให้ค่ารหัสตัวแปรจากแบบสอบถาม ดังนี้ 
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แบบสอบถามเพื่อการวิจัย หมายเลข........... 
ส าหรับเจ้าหน้าที่ 

ตอนท่ี 1 สถานภาพส่วนบุคคล 
            ค าช้ีแจง  กรุณากาเครื่องหมาย      ลงในช่อง    ที่ตรงกับความเป็นจริงของ
ท่าน     
 

1. เพศ               1.ชาย                         2. หญิง 
2. อายุ.........................ปี 
3. ประสบการณ์ในการท างาน........................ ปี 
4. ระดับการศึกษา 
        1.  ต่ ากว่าปริญญาตรี   2. ปริญญาตรี       3.ปริญญาโทข้ึนไป 
5. ขนาดโรงเรียนที่ท างานอยู่ปัจจุบัน 
        1. ขนาดเล็ก        2. ขนาดกลาง          3. ขนาดใหญ่   
 

 
 
 
SEX      
AGE     
EXP      
EDU     
 
SIZE    

 

 จากตัวอย่างแบบสอบถาม จะเห็นว่า ทางด้านขวามีชื่อตัวแปรก าหนดไว้ โดยการตั้งชื่อตัว
แปรจะเป็นภาษาไทยหรืออังกฤษก็ได้ การก าหนดชื่อตัวแปรที่จะใช้ประมวลผลด้วยคอมพิวเตอร์นั้น
ควรก าหนดชื่อให้สอดคล้องกับตัวตัวแปรในการวิจัยในเรื่องนั้นๆ ซึ่งจะท าให้สะดวกต่อการจ าและท า
ความเข้าใจ  ในกรณีที่ใช้โปรแกรม SPSS for Window จะมีความยาวไม่เกิน 8 ตัวอักษรซึ่งจะ
กล่าวถึงในรายละเอียดต่อไป นอกจากนี้จะมีชองสี่เหลี่ยมส าหรับใส่ค่ารหัสของตัวแปร ซึ่งได้มาจาก
การตอบแบบสอบถาม ผู้วิจัยควรท าสมุดคู่มือการก าหนดรหัสให้ตัวแปร โดยก าหนดชื่อตัวแปร ชนิด
ของตัวแปร ขนาดของตัวแปร และการให้ค่ารหัสตัวแปร 
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ตัวอย่างการจัดท่าคู่มือการลงรหัส 
 
ค าถามที ่ ช่ือตัวแปร รายการข้อมูล ขนาดตัวแปร

(จ านวนหลัก) 
ค่ารหัส ข้อสังเกต 

1 SEX ช่ือ 1 1 ชาย 
2หญิง  
9ไม่ตอบ/ตอบสองข้อ 

เลือกได้ค าตอบ
เดียว 

2 AGE อาย ุ 2 ตามจริง 
99 ไม่ตอบ 

อายุจริง 

3 EXP ประสบการณ์ 2 01 – 40 ตามจริง 
99  ไม่ตอบ 

ปร ะส บ กา ร ณ์
จริง 

4 EDU การศึกษา 1 1 ต่ ากว่าปริญญาตรี 
2 ปริญญาตรี 
3 ปริญญาโทข้ึนไป 
9ไม่ตอบ 

เลือกได้ค าตอบ
เดียว 

5 SIZE ขนาดโรงเรียน 1 1 ขนาดเล็ก 
2ขนาดกลาง 
3ขนาดใหญ่ 
9ไม่ตอบ 

เลือกได้ค าตอบ
เดียว 

 

 การจัดท าคู่มือลงรหัสจะท าให้การลงข้อมูลได้ไม่ผิดพลาดโดยเฉพาะเมื่อตัวแปรมีจ านวนมาก  
อย่างไรก็ตามในบางครั้งจะน าข้อมูลที่ได้จากเครื่องมือการวิจัย ไปเขียนลงในกระดาษลงรหัส(Paper 
code) แล้วค่อยน าข้อมูลที่ลงรหัสในการกระดาษลงรหัสไปลงในโปรแกรมคอมพิวเตอร์ ในกรณี
อาจจะเป็นการท าข้อมูลซ้ าซ้อนแต่จะสะดวกต่อการลงรหัสในโปรแกรม SPSS มากขึ้น และยังสะดวก
ต่อการตรวจสอบในกรณีลงรหัสในโปรแกรมผิด เป็นประโยชน์ก็ได้  ซึ่งในกระดาษลงรหัสนี้จะมี
ลักษณะคล้ายกับหน้าต่าง Data editor ของ SPSS for window ซึ่งจะประกอบด้วย หมายเลข
แบบสอบถาม ตัวแปร และค่ารหัสของตัวแปร ดังตัวอย่าง 
 
 
 
ห ม า ย เ ล ข
แบบสอบถาม 

ตัวแปร (เท่ากับจ านวนข้อค าถามในเครื่องมือการวิจัย) 
SEX AGE EXP EDU SIZE …. 

1 1 42 5 1 1 …. 
2 1 35 7 1 1 …. 
3 2 39 9 2 2 …. 
4 1 48 10 3 3 …. 
5 2 50 7 2 3 …. 
. 
. 
. 

. 

. 

. 

. 

. 

. 

. 

. 

. 

. 

. 

. 

. 

. 

. 

. 

. 

. 
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การใช้โปรแกรม SPSS for Windows 
 

โปรแกรม SPSS เป็นโปรแกรมที่ใช้ในการวิเคราะห์ข้อมูลทางสถิติที่ได้รับความนิยมอย่าง
แพร่หลายมานานตั้งแต่ ยังใช้ เวอร์ชัน DOS จนกระทั่ง เวอร์ชันที่ใช้ใน Windows ได้มีการพัฒนา
และปรับปรุงอยู่ตลอด โปรแกรม SPSS มีความสามารถมากมายแต่ส าหรับการใช้โปรแกรม SPSS ใน
เนื้อหานี้จะพูดถึงส่วนที่จ าเป็นและเก่ียวข้องกับการเรียนการสอนเท่านั้น  
 

การเปิด File หรือ การสร้าง File ใหม่ 
 Start > Program > Spss ได้ดังภาพที่ 1 

 
ภาพที่ 1 
 

ในกรณีที่เรา กดปุ่ม Cancel เราจะได้ หน้าต่าง SPSS Data Editor ซึ่งเป็นหน้าต่างส าหรับ
กรอกและแก้ไขข้อมูล รวมทั้งการประมวลผลอ่ืนๆ 

ผลการเปิดโปรแกรมคร้ังแรก 
สามารถเปิด file เดิมท่ีมียู่
แลว้(เคยใชง้าน) หรือ click 

ท่ี cancel เพื่อเปิดหรือสร้าง 
file ใหม่ 
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ภาพที่ 2 
 

ในกรณีที่ต้องการเปิด File ที่มีอยู่แล้วให้ Click ที่ File > Open > Data  หรือ Click ที่ 

  บน Tool Bar จะได้หน้าจอ ดังภาพที่ 3 หลังจากนั้นให้เลือก File ทีเราต้องการ และ Click ที่ 
Open  ในภาพเป็นการเปิด File ชื่อ Car 

 
ภาพที่ 3 

 
 
 

เปิด File ใหม่ : เลือก 
file ท่ีตอ้งการเปิด แลว้ 
click ท่ี open 

1 

2 
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ผลการเปิด File จะได้ดังภาพที่ 4 

 
ภาพที่ 4 

 
การก่าหนดชื่อและค่าตัวแปร (Name) 
 อย่างไรก็ตาม ในกรณีที่เป็น File ยังไม่กรอกข้อมูล หรือ ยังไม่ก าหนดชื่อและค่าตัวแปร สิ่งที่
เราต้องท าก่อนวิเคราะห์ข้อมูล ก็คือ การก าหนดชื่อและค่าต่างๆให้ตัวแปร โดยการ Double Click ที่ 
Var จะได้ผลดังภาพที ่5  

 
ภาพที ่5 
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 ในการก าหนดชื่อตัวแปรในโปรแกรม SPSS นั้นสามารถก าหนดได้ทั้งที่เป็น ภาษาไทยและ
ภาษาอังกฤษ แต่จะก าหนดได้เพียง 8 ตัวอักษร  และการก าหนดชื่อตัวแปรนั้นควรก าหนดให้
สอดคล้องกับสภาพจริงของตัวแปร เช่น ตัวแปร เพศ ก็ควรก า เพศ หรือ SEX  เป็นต้น การก าหนด
ชื่อตัวแปรใน SPSS จะก าหนดได้ไม่เกิน 8 ตัวอักษร  
 
 

 
   ภาพที่ 6 
  

จากคู่มือลงรหัสจะพบว่าเพศได้ก าหนดให้เป็น Sex และยังพบอีกว่าก าหนดให้ 1 แทนชาย 
และ 2 แทนหญิง ดังนั้นในโปรแกรมจะต้องท าการแทนเลขดั งดั งกล่ าวด้วย โดยคลิกที่ 

 จะได้ดังภาพที่ 7 

 
ภาพที่ 7 

 

Click แลว้พิมพช่ื์อตวัแปรซ่ึงในท่ีน้ีก าหนดเป็น sex  
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กรอกค่าที่ก าหนดให้กับตัวแปร ในทีนี้ตัวแปรเพศ ก าหนดให้ เพศชาย เป็น 1 และ เพศหญิง
เป็น 2    ขัน้ตอนในก าหนดค่าฉลาก 

 1. พิมพ์ เลข 1  ลงในช่อง   Value 
 2. พิมพ์  male ลงในช่อง Value Label  (สามารถกรอกเป็นภาษาไทยได้) 
 3. กดปุ่ม Add  
 ในกรณีก าหนดค่าให้เพศหญิง ท าเช่นเดียวกับ เพศชาย เพียงเปลี่ยนจาก 1 เป็น 2 

และเปลี่ยนจาก mail เป็น female  ส่วน ปุ่ม Change มีไว้ส าหรับแก้ไข และถ้าต้องการลบออก ให้
กด Remove  

 ส่วนตัวแปรตัวอ่ืนๆ ก็ท าเช่นเดียวกับตัวแปร sex  
เมื่อกรอกชื่อตัวแปรครบทุกตัวแล้ว ก็จะได้ดังภาพที่ 8 

 
ภาพที่ 8 
 
 
 
 
 

 
 
 

 
 
 
 
 
 
 

โดยปกติ ตัวแปรทีต้่องก าหนดค่านี ้จะเป็นตัวแปรทีม่ีระดับการวดั 
เป็น Nominal หรือ Ordinal ส่วนตัวแปรทีม่ีระดับการวดัตั้งแต่ 

Interval ขึน้ไปมักไม่นิยมก าหนดค่า 
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จากนั้นก็ท าการใส่ข้อมูลที่เราเตรียมไว้ส าหรับการวิเคราะห์ ก็จะได้ดังภาพที่ 9 

 
ภาพที่ 9 

 
 

การวิเคราะห์ข้อมูล (สถิติพรรณนา)  
 
การหาค่าความถี่และร้อยละ (ข้อมูลเชิงคุณภาพ) 
 เปิดโปรแกรม Spss > เปิดไฟล์ที่ต้องการวิเคราะห์ (สมมุติข้อมูลข้างต้น) จะได้ภาพที่ 10 

 
ภาพที่ 10 
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จากนั้นคลิก Analyze > Descriptive Statistics > Frequencies ดังภาพที ่11 

 
   ภาพที่ 11 

 
 
 
จากภาพที่ 11 จะได้ภาพที่ 12 ดังนี้ 
 
 
 
 
 

 
  ภาพที่ 12  
 

1. เลือกตวัแปรท่ีตอ้งการหาค่าความถ่ี
และร้อยละ ซ่ึงในท่ีน้ีตอ้งการหาความถ่ี
ของ sex  

2 กด OK 
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จะได้ผลลัพธ์ดังภาพที่ 13 

 
ภาพที่ 13 

 
 

ตัวอย่างการน่าเสนอผลการวิเคราะห์ข้อมูลและการแปลผล 
ตารางท่ี 1 แสดงจ่านวนและร้อยละของข้อมูลส่วนบุคคลของกลุ่มตัวอย่าง  
ข้อมูลส่วนบุคคล (n=100) จ่านวน ร้อยละ 
เพศ 
     ชาย 
     หญิง 
ศาสนา 
     พุทธ 
     คริสต์ 
     อิสลาม 

 
75 
25 
 
60 
30 
10 

 
75.0 
25.0 
 
60.0 
30.0 
10.0 

 
จากตารางที่ 1 พบว่า กลุ่มตัวอย่างจ านวน 100 คน ส่วนใหญ่เป็นเพศชายมากที่สุด ร้อยละ 

75.0 ส่วนศาสนากลุ่มตัวอย่างนับถือศาสนาพุทธมากที่สุด ร้อยละ 60.0 รองลงมานับถือศาสนาคริสต์ 
ร้อยละ 30.0   
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การหาค่าเฉลี่ยและค่าเบี่ยงเบนมาตรฐาน (ข้อมูลเชิงปริมาณ) 
 เปิดโปรแกรม Spss > เปิดไฟล์ที่ต้องการวิเคราะห์ (สมมุติข้อมูลข้างต้น) จะได้ภาพที่ 14 

 
ภาพที่ 14 

 
จากนั้นคลิก Analyze > Descriptive Statistics > Descriptive ดังภาพที่ 15 

 
ภาพที่ 15 
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จากภาพที่ 15 จะได้ภาพที่ 16 ดังนี้ 
 
 
 
 
 

 
   ภาพที่ 16 
 

 
 
 
จะได้ผลลัพธ์ดังภาพที่ 17 

 
 

ภาพที่ 17 
 
 

1. เลือกตวัแปรท่ีตอ้งการหาค่าเฉล่ียและ
ค่าเบ่ียงเบนมาตรฐาน ซ่ึงในท่ีน้ีตอ้งการ
หาค่าของ age  

2 กด OK 
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ตัวอย่างการน่าเสนอผลการวิเคราะห์ข้อมูลและการแปลผล 
ตาราง 2 แสดง อายุ รายได้ต่อเดือนของกลุ่มตัวอย่าง 
ตัวแปร ค่าเฉลี่ย ค่าเบ่ียงเบนมาตรฐาน 
อาย ุ 35.5 12.0 
รายได้ 6750.57 38.75 

 
 จากตาราง 2 พบว่า กลุ่มตัวอย่างมีอายุเฉลี่ย 35.5 ปี มีรายได้เฉลี่ยเดือนละ 6750.57 บาท 

 
 

การวิเคราะห์ข้อมูล (สถิติอนุมาน )  
 

การทดสอบ t-test 
 กระบวนการทางสถิติ t-test เป็นการแจกแจกแบบ Student’s ส าหรับเปรียบเทียบค่าเฉลี่ย 
2 ค่า นอกจากนั้นยังแสดงค่าเฉลี่ย ส่วนเบี่ยงเบนมาตรฐานและความคลาดเคลื่อนมาตรฐานในแต่ละ
ตัวแปรด้วย ซึ่งสถิติ t-test สามารถแบ่งการวิเคราะห์ได้เป็น 2 กรณี 
 กรณีท่ี 1 กลุ่มตัวอย่างทั้ง 2 ไม่สัมพันธ์กัน (อิสระต่อกัน) เรียกว่า Independent t-test 
 ถ้ากลุ่มตัวอย่างทั้ง 2 ไม่สัมพันธ์กัน (อิสระต่อกัน) ในการทดสอบสมมุติฐานที่ต้องการหา
ความแตกต่างของค่าเฉลี่ยของกลุ่มตัวอย่างกลุ่มหนึ่งว่าแตกต่างจากอีกกลุ่มหนึ่งหรือไม่ เช่น ต้องการ
ทดสอบผลสัมฤทธิ์ทางการเรียนของกลุ่มที่ได้รับการสอนแบบปกติกับกลุ่มที่ได้รับการสอนแบบพิเศษ
ว่าจะมีคะแนนเฉลี่ยแตกต่างจากกันหรือไม่ ในกรณีนี้กลุ่มตัวอย่างสองกลุ่มเป็นอิสระจากกัน เรา
สามารถตั้งสมมุติฐานได้ดังนี้ 
  สมมุติฐาน 1 210 :H   

    211 :H   หรือ 

  สมมุติฐาน 2 210 :H   

    211 :H   หรือ 

  สมมุติฐาน 3 210 :H   
    211 :H   

  สูตรค านวณ 
  ขั้นแรก ค านวณหาว่ากลุ่มตัวอย่างทั้งสองกลุ่มมีความแปรปรวนแตกต่างกันหรือไม่ 
ด้วยสูตร F-test มีสมมุติฐานดังนี้ 

    2
2

2
10 :H   

    2
2

2
11 :H   
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   ค านวณด้วยสูตร 

    1ndf;1ndf;
S

S
F 22112

2

2
1   

  พิจารณาค่า F-test ถ้า F-test ที่ค านวณได้ไม่มีนัยส าคัญทางสถิติ (Sig >  ) นั่น
คือยอมรับ H0 แสดงว่าความแปรปรวนของทั้งสองกลุ่มเท่ากัน จะใช้สูตรที่ 1 (Pooled Variance) ถ้า
ค่า F-test ที่ค านวณได้มีนัยส าคัญทางสถิติ (Sig <  ) นั่นคือปฏิเสธ H0 ยอมรับ H1 แสดงว่าความ
แปรปรวนของทั้งสองกลุ่มไม่เท่ากัน จะใช้สูตรที่ 2  แทน (Separate Variance) 
   

ขั้นที่สอง เลือกใช้สูตรค านวณค่า t-test 

   สูตรที่ 1 เมื่อ 2
2

2
1   

    
   


















2121

2
22

2
11

21

n
1

n
1

2nn
S1nS1n

XX
t  

    2nndf 21   

   สูตรที่ 2 เมื่อ 2
2

2
1   

    

2

2
2

1

2
1

21

n
S

n
S

XX
t




  

    

1n

n
S

1n

n
S

n
S

n
S

df

2

2

2

2
2

1

2

1

2
1

2

2

2
2

1

2
1

















































  

 
การพิจารณาหากค่าสถิติ t ที่ค านวณได้ไม่มีนัยส าคัญทางสถิติ (Sig >  ) นั่นคือ

ยอมรับ H0 แสดงว่าค่าเฉลี่ยของ 2 กลุ่มไม่มีความแตกต่างกัน ถ้าค่า t ที่ค านวณได้มีนัยส าคัญทาง
สถิติ (Sig <  ) นั่นคือปฏิเสธ H0 ยอมรับ H1 แสดงว่ามีค่าเฉลี่ยของ 2 กลุ่มแตกต่างกัน (มากกว่า 
หรือน้อยกว่า) 
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ขั้นตอนการทดสอบ t-test  แบบกลุ่มตัวอย่างเป็นอิสระจากกัน 
 
เปิดโปรแกรม SPSS 

Analyze  > Compare Means > Independent-Sample T Test ดังภาพที่ 18 
 
 

 
ภาพที ่18 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



1 

 
 
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ผลจะได้ หน้าต่าง Independent Sample T test หลังจากนั้นให้ท าตามข้ันที่ 1 ถึง ขั้นตอนที่ 8 ดัง
ภาพที่ 19 
 
 
 
 

 
 
 
 
 
 
 
 

 
ภาพที1่9 

 
 
 

1.เลือกตวัแปรท่ีตอ้งการ
ทดสอบ 

2. click 

3. ช่องส าหรับตวัแปรตามท่ีตอ้งการทดสอบ 
(ขอ้มูลเชิงปริมาณ) สามารถใส่ไดม้ากกวา่หน่ึงตวั
แปร 

4.ช่องส าหรับตวัแปรอิสระ 
(ขอ้มูลเชิงคุณภาพ: 2 กลุ่ม) ซ่ึงตอ้ง
เลือกมาจากช่องตวัแปรดา้นซา้ย 
เม่ือเลือกแลว้ใหก้ดปุ่ม 5 

5. Click 

6.ก าหนดกลุ่ม เพ่ือเป็น
ระบุกลุ่มท่ีตอ้งการ
เปรียบ 

7.ใส่ค่าของตวัแปรลงไป ในท่ีน้ี 1 หมายถึง 
เพศชาย 2 หมายถึงเพศหญิง หลงัจากนั้น 
click ปุ่ม Continue 

8. Click ปุ่ม OK 

ภาพประกอบ 16 
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ผลการวิเคราะห์ข้อมูลจะได้ หน้าต่างที่เรียกว่า SPSS Viewer ดังภาพที่ 20  
 

 
ภาพที ่20 

 
จากตารางเป็นการแสดงสถิติพรรณนา (ค่าเฉลี่ยและค่าเบี่ยงเบนมาตรฐาน) โดยที่ตัวแปร 

EANIETY ของเพศชายมีค่าเฉลี่ย 2.82 และของเพศหญิงมีค่าเฉลี่ย 3.72 เป็นต้น 

ตวัแปรตาม ตวัแปรอิสระ 
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การทดสอบความเท่ากันของความแปรปรวน โดยใช้ F –test  การพิจารณาว่าความ
แปรปรวนเท่ากันหรือไม่ให้ดูได้จากช่อง Sig (หมายถึงระดับนัยส าคัญทางสถิติ)  ถ้าค่า Sig > 0.05 
แสดงว่า ความแปรปรวนเท่ากัน แต่ถ้า Sig < 0.05  แสดงว่า ความแปรปรวนแตกต่างกันอย่างมี
นัยส าคัญทางสถิติ 

 ผลการทดสอบสมมติฐานด้วย t-test จะเห็นว่า ค่า t มี 2 ค่า จะใช้ค่าใดขึ้นอยู่กับผลการ
ทดสอบความเท่ากันของความแปรปรวน ถ้า F-test ไม่มีนัยส าคัญทางสถิติ (Sig > 0.05) ให้ใช้ค่าบน   
แต่ถ้ามีนัยส าคัญทางสถิต ิ(Sig < 0.05) ให้ใช้ค่าล่าง จากตาราง ในกรณีตัวแปร EANXIETY พบว่า ค่า 
F ไม่มีนัยส าคัญทางสถิติ (Sig > 0.05) แสดงว่าความแปรปรวนเท่ากัน ค่า t ที่ใช้ คือ -5.393 ,df=88 
และ sig = .000 (sig < 0.05) ซึ่งหมายความว่า ครูอาจารย์ที่มีเพศต่างกันมีความวิตกกังวลใน
เหตุการณ์แตกต่างกันอย่างมีนัยส าคัญทางสถิติที่ระดับ 0.05 ส่วนตัวแปร PERFOM ก็อ่านค่าใน
ลักษณะเดียวกัน 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  
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ตัวอย่างท่ี 1 นักเรียนในกรุงเทพฯจะมีทัศนะคติทางวิทยาศาสตร์ดีกว่านักเรียนในชนบท 
จากตัวอย่างที่ 1 มีตัวแปรที่เกี่ยวข้อง 2 ตัว คือ 1) ภูมิล าเนาของนักเรียน (กรุงเทพฯ และ

ชนบท) 2) ทัศนะคติทางวิทยาศาสตร์ (วัดออกมาเป็นตัวเลข) 
 

คนที ่ ภูมิล่าเนาของนักเรียน ทัศนะคติทางวิทยาศาสตร์ 
1 
2 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
20 

กรุงเทพ  
กรุงเทพ  
ชนบท 
กรุงเทพ  
ชนบท 
กรุงเทพ  
ชนบท 
ชนบท 
ชนบท 
กรุงเทพ  
กรุงเทพ  
ชนบท 
กรุงเทพ  
ชนบท 
กรุงเทพ  
ชนบท 
ชนบท 
กรุงเทพ  
กรุงเทพ  
ชนบท 

4 
2 
1 
5 
3 
2 
4 
2 
1 
3 
5 
4 
2 
3 
5 
5 
2 
2 
1 
3 

 
 การตั้งสมมุติฐาน H0    :  1   =   2  

   H1     :  1     2  

 โดยที่  1 คือ ค่าเฉลี่ยของทัศนะคติทางวิทยาศาสตร์ของนักเรียนในกรุงเทพ 

  2 คือ ค่าเฉลี่ยของทัศนะคติทางวิทยาศาสตร์ของนักเรียนในชนบท 

 สถิติที่จะใช้ในการทดสอบ คือ Independent t-test 
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ขั้นตอนการวิเคราะห์ 
 เปิดโปรแกรม Spss จะได้ภาพที่ 21 

 
ภาพที่ 21 
 
 ท าการก าหนดชื่อตัวแปรและลงรหัสข้อมูล (ตามขั้นตอนข้างต้น) ดังภาพที่ 22 
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ภาพที่ 22 
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คลิก Analyze  > Compare Means > Independent-Sample T Test ดังภาพที ่23 

 
ภาพที่ 23 

 
จะได้หน้าจอดังภาพที่ 24 ท าการใส่ตัวแปรที่ต้องการวิเคราะห์  
 ในช่อง Test Variable เลือกตัวแปร att 
 ในช่อง Grouping Variable เลือกตัวแปร add แล้วคลิก  เพ่ือก าหนดกลุ่ม 

โดยที่  Group 1 ให้ใส่เลข 1 หมายถึงกลุ่มกรุงเทพ 
 Group 2 ให้ใส่เลข 2 หมายถึงกลุ่มชนบท  
คลิก Continue 

 แล้วคลิก OK  
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ภาพที่ 24 

 
ผลการวิเคราะห์จะได้ดังภาพที่  

Group Statistics

10 3.1000 1.5239 .4819

10 2.8000 1.3166 .4163

add

bankok

countryside

ATT

N Mean

Std.

Dev iation

Std.  Error

Mean

 

  
ตารางนี้แสดงค่าสถิติพ้ืนฐาน (ค่าเฉลี่ยและค่าเบี่ยงเบนมาตรฐาน) พบว่า ค่าเฉลี่ยทัศนคติทาง

วิทยาศาสตร์ของนักเรียนกรุงเทพมีค่า 3.10 ส่วนของนักเรียนชนบนมีค่า 2.80 
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Independent Samples Test

.854 .368 .471 18 .643 .3000 .6368 -1.0379 1.6379

.471 17.628 .643 .3000 .6368 -1.0400 1.6400

Equal variances

assumed

Equal variances

not assumed

ATT

F Sig.

Levene's Test f or

Equality  of  Variances

t df

Sig.

(2-tailed)

Mean

Dif f erence

Std.  Error

Dif f erence Lower Upper

95% Conf idence

Interv al of  the

Dif f erence

t-test  for Equality  of  Means

 
 

จากตารางจะแบ่งการทดสอบเป็น 2 กรณี  
กรณีท่ี 1 เป็นการทดสอบความแปรปรวนโดยใช้สถิติ F-test ซึ่งมีสมมุติฐานดังนี้ 

2
2

2
10 :H   

    2
2

2
11 :H   

พบว่า ค่าสถิติ F-test = 0.845 และค่า Sig = 0.368 ซึ่งมากกว่า 0.05 ดังนั้นจึงสรุปว่า 
ยอมรับสมมุติฐาน H0 ดังนั้นสรุปว่า ความแปรปรวนของทั้งสองกลุ่มเท่ากันกัน 

 
กรณีท่ี 2 เป็นการทดสอบค่าเฉลี่ย โดยใช้สถิติ t-test ซึ่งมีสมมติฐาน ดังนี้ 

    210 :H   
    211 :H   

พบว่า ค่าสถิติ t-test = 0.471 และค่า Sig = 0.643 (2-tailed) แต่เราต้องการทดสอบทาง
เดียวดังนั้นค่า Sig = 0.643/2 = 0.3215 (1-tailed) ซ่ึงมากกว่า 0.05 ดังนั้นจึงสรุปว่ายอมรับ
สมมุติฐาน H0 ดังนั้นสรุปว่า 210 :H  หมายความว่านักเรียนในกรุงเทพฯจะมีทัศนะคติทาง

วิทยาศาสตร์ที่เท่ากับ (ไม่แตกต่าง) กับนักเรียนในชนบท 
 
การน่าเสนอผลการวิเคราะห์ด้วย Independent t-test 
ตารางท่ี 3 แสดงการเปรียบเทียบทัศนคติทางวิทยาศาสตร์ของนักเรียนในกรุงเทพและชนบท 
เพศ จ่านวน ค่าเฉลี่ย ค่าเบ่ียงเบนมาตรฐาน ค่า t Sig. 
กรุงเทพ 
ชนบท 

10 
10 

3.10 
2.80 

1.52 
1.31 

0.471 0.322 

* P<0.05 
จากการทดสอบ พบว่า นักเรียนในกรุงเทพฯ และในชนบทจะมีทัศนะคติทางวิทยาศาสตร์ที่

ไม่แตกต่างกันอย่างมีนัยส าคัญทางสถิติที่ 0.05 
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กรณีท่ี 2 กลุ่มตัวอย่างทั้ง 2 สัมพันธ์กัน เรียกว่า Pair t-test  
 ถ้ากลุ่มตัวอย่างทั้ง 2 สัมพันธ์กัน ในการเปรียบเทียบค่าเฉลี่ยสองค่าว่าแตกต่างกันหรือไม่ 
โดยค่าเฉลี่ยทั้งสองค่านี้วัดมาจากกลุ่มตัวอย่าง 2 กลุ่มที่สัมพันธ์กัน โดยอาจจะวัดมาจากกลุ่มตัวอย่าง
กลุ่มเดียวกัน 2 ครั้ง หรือวัดมากจากกลุ่มตัวอย่าง 2 กลุ่มที่ได้มาจากการจับคู่คุณลักษณะที่เท่าเทียม
กัน มีวิธีการค านวณหาความแตกต่างของค่าเฉลี่ย ดังนี้ 

ลักษณะการตั้งสมมุติฐาน  H0     : ก่อน    =   หลงั  

    H1     :  ก่อน      หลงั  หรือ 

    H0     : ก่อน    =   หลงั  

    H1     :  ก่อน  >   หลงั  หรือ 

H0     : ก่อน    =   หลงั  

    H1     :  ก่อน  <   หลงั  

    
  สูตรค านวณ 

   
1n

)dd(
Sและ

n
d

dโดยท่ี

n
S
d

t dd 




  

   1ndf   
 

การพิจารณาหากค่าสถิติ t ที่ค านวณได้ไม่มีนัยส าคัญทางสถิติ (Sig >  ) นั่นคือยอมรับ H0 
แสดงว่าค่าเฉลี่ยก่อนและหลังไม่มีความแตกต่างกัน ถ้าค่า t ที่ค านวณได้มีนัยส าคัญทางสถิติ (Sig < 
 ) นั่นคือปฏิเสธ H0 ยอมรับ H1 แสดงว่ามีค่าเฉลี่ยก่อนและหลังแตกต่างกัน (ก่อนมากกว่าหลัง หรือ
ก่อนน้อยกว่าหลัง) 
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ขั้นตอนการทดสอบ t-test  แบบกลุ่มตัวอย่างท่ีสัมพันธ์กัน 
 
เปิดโปรแกรม SPSS 

Analyze  > Compare Means > Paired-Sample T Test ดังภาพที่ 25 
 
 

 
ภาพที่ 25 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



1 
  
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ผลจะได้ หน้าต่าง Paired Sample T test ดังภาพที่ 26 
 
 
 
 

 
ภาพที่ 26 

 
 
 

ต่อมาคลิก  จะได้ภาพที่ 27 แล้วคลิก OK 

 
ภาพที่ 27 

 
 
 
 
 
 
 

1 เลือกตวัแปร before 

2 เลือกตวัแปร after 

3 ตวัแปร before และ 
after จะปรากฏในช่องน้ี 

 Click ปุ่ม OK 
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ผลการวิเคราะห์ข้อมูลจะได้ดังภาพที ่28 

 
 

ภาพที่ 28 
T-Test 
 

Paired Samples Statistics

6.1600 50 1.6081 .2274

5.8600 50 1.9379 .2741

BEFORE

AFTER

Pair

1

Mean N

Std.

Dev iation

Std.  Error

Mean

 
 

จากตารางเป็นการแสดงสถิติพรรณนา (ค่าเฉลี่ยและค่าเบี่ยงเบนมาตรฐาน) โดยที่ตัวแปร 
BEFORE มีค่าเฉลี่ย 6.10 และ AFTER มีค่าเฉลี่ย 5.86  
 
 

Paired Samples Correlations

50 .197 .170BEFORE & AFTERPair 1

N Correlation Sig.

 
 

 จากตารางแสดงความสัมพันธ์ระหว่างตัวแปร BEFORE และ AFTER ซึ่งมีความสัมพันธ์ 
0.197 แต่ว่าไม่มีความสัมพันธ์กัน (Sig > 0.05) 
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Paired Samples Test

.3000 2.2610 .3198 -.3426 .9426 .938 49 .353BEFORE - AFTERPair 1

Mean

Std.

Deviation

Std.  Error

Mean Lower Upper

95% Conf idence

Interv al of  the

Dif f erence

Paired Dif f erences

t df

Sig.

(2-tailed)

 
 

ผลการทดสอบสมมติฐานด้วย t-test จะเห็นว่า ค่า t คือ 0.938 ,df=49 และ sig = .353 
(sig > 0.05) ซึ่งหมายความว่า ก่อนและหลังการทดสอบไม่มีความแตกต่างกันอย่างมีนัยส าคัญทาง
สถิติที่ 0.05 
 
ตัวอย่างท่ี 2 ผลการเรียนรู้ก่อนเข้าค่ายของนักศึกษาน้อยกว่าผลการเรียนรู้หลังเข้าค่ายของนักศึกษา 

จากตัวอย่างท่ี 2 มีตัวแปรที่เกี่ยวข้อง 2 ตัวคือ 1) ผลการเรียนรู้ก่อนเข้าค่าย (วัดออกมาเป็น
ตัวเลข) 2) ผลการเรียนรู้หลังเข้าค่าย (วัดออกมาเป็นตัวเลข) 

 
คนที ่ ผลการเรียนรู้ก่อนเข้าค่าย ผลการเรียนรู้หลังเข้าค่าย 
1 
2 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
20 

4.00 
8.00 
5.00 
4.00 
3.00 
5.00 
5.00 
4.00 
8.00 
4.00 
7.00 
5.00 
4.00 
3.00 
2.00 
6.00 
2.00 
5.00 
8.00 
4.00 

4.00 
8.00 
7.00 
5.00 
6.00 
3.00 
2.00 
5.00 
8.00 
7.00 
9.00 
6.00 
5.00 
8.00 
4.00 
5.00 
7.00 
8.00 
5.00 
6.00 

 
การตั้งสมมุติฐาน H0     : ก่อน    =   หลงั  

   H1     :  ก่อน  <   หลงั  

 โดยที่  ก่อนคือ ค่าเฉลี่ยของผลการเรียนรู้ก่อนเข้าค่ายของนักศึกษา 



  

 

41 

หลงัคือ ค่าเฉลี่ยของผลการเรียนรู้หลังเข้าค่ายของนักศึกษา 

 สถิติที่จะใช้ในการทดสอบ คือ Pair t-test 
 
ขั้นตอนการวิเคราะห์ 
 เปิดโปรแกรม Spss จะได้ภาพที่ 29 

 
ภาพที่ 29 

 
 ท าการก าหนดชื่อตัวแปรและลงรหัสข้อมูล (ตามขั้นตอนข้างต้น) ดังภาพที่ 30 
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ภาพที่ 30 

 
 

คลิก Analyze  > Compare Means > Paired-Sample T Test ดังภาพที ่31 
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ภาพที่ 31 

 
 

จะได้หน้าจอดังภาพที่ 32 ท าการเลือกตัวแปรที่ต้องการวิเคราะห์ ในที่นี้เลือก before และ after  
แล้วคลิด OK 

 
ภาพที่ 32 
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ผลการวิเคราะหจ์ะได้ดังนี้ 
 
T-Test 
 

Paired Samples Statistics

4.8000 20 1.8238 .4078

5.9000 20 1.8610 .4161

BEFORE

AFTER

Pair

1

Mean N

Std.

Dev iation

Std.  Error

Mean

 
 

จากตารางเป็นการแสดงสถิติพรรณนา (ค่าเฉลี่ยและค่าเบี่ยงเบนมาตรฐาน) โดยที่ตัวแปร 
BEFORE มีค่าเฉลี่ย 4.80 และ AFTER มีค่าเฉลี่ย 5.90  
 

Paired Samples Correlations

20 .257 .273BEFORE & AFTERPair 1

N Correlation Sig.

 
 
 จากตารางแสดงความสัมพันธ์ระหว่างตัวแปร BEFORE และ AFTER ซึ่งมีความสัมพันธ์ 
0.257 แต่ว่าไม่มีความสัมพันธ์กัน (Sig > 0.05) 
 

Paired Samples Test

-1.1000 2.2455 .5021 -2.1509 -4.91E-02 -2.191 19 .041BEFORE - AFTERPair 1

Mean

Std.

Deviation

Std.  Error

Mean Lower Upper

95% Conf idence

Interv al of  the

Dif f erence

Paired Dif f erences

t df

Sig.

(2-tailed)

 
 
 จากตารางเป็นการทดสอบสมมุติฐาน ดังนี้ 

  H0     : ก่อน    =   หลงั  

  H1     :  ก่อน  <   หลงั  

ผลการทดสอบสมมติฐานด้วย t-test จะเห็นว่า ค่า t คือ -2.191 ,df=19 และ sig = 
0.041(2-tailed) แต่เราต้องการทดสอบทางเดียว ดังนั้นค่า sig = 0.041/2=0.0205 (1-tailed) ซึ่ง
น้อยกว่า 0.05ดังนั้นจึงปฎิเศษสมมุติฐาน H0 ยอมรับสมมุติฐาน H1 คือ H1     :  ก่อน  <   
หลงัซึ่งหมายความว่า ผลการเรียนรู้ก่อนการเข้าค่ายของนักศึกษาน้อยกว่าผลการเรียนรู้หลังการ

เข้าค่ายของนักศึกษาอย่างมีนัยส าคัญทางสถิติที่ 0.05 
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การน่าเสนอผลการวิเคราะห์ด้วย Paired t-test 
ตารางท่ี 4  แสดงการเปรียบเทียบผลการเรียนรู้ก่อนและหลังการเข้าค่ายของนักเรียน 
การเรียนรู ้ จ่านวน ค่าเฉลี่ย ค่าเบ่ียงเบนมาตรฐาน ค่า t Sig. 
ก่อน 
หลัง 

20 
20 

4.80 
5.90 

1.82 
1.86 

-2.191* 0.021 

* P<0.05 
จากการทดสอบ พบว่า ผลการเรียนรู้ก่อนการเข้าค่ายของนักศึกษาน้อยกว่าผลการเรียนรู้

หลังการเข้าค่ายของนักศึกษาอย่างมีนัยส าคัญทางสถิติที่ 0.05 
 
 

การวิเคราะห์ความแปรปรวนทางเดียว  One - way ANOVA 
การวิเคราะห์ความแปรปรวนแบบทางเดียว (One-way ANOVA) เป็นการทดสอบความ

แตกต่างของประชากรที่มีลักษณะที่สนใจลักษณะเดียวแต่มีข้อมูลจากหลายประชากร  
จากความหมายดังกล่าวอาจกล่าวได้ว่าเป็นการทดสอบความแตกต่างระหว่างค่าเฉลี่ยของ

ประชากรตั้งแต่สองประชากรขึ้นไปที่มีลักษณะที่ต้องการทดสอบเพียงลักษณะเดียว เช่น การทดสอบ
ระหว่างคะแนนเฉลี่ยของนักเรียนที่สอบคัดเลือกเข้ามหาวิทยาลัย 4 โรงเรียน ว่ามีความแตกต่างกัน
หรือไม่ เป็นต้น ซึ่งตัวแปรที่ใช้ในการวิเคราะห์ ตัวแปรตามจะต้องมีระดับการวัดอยู่ในระดับอันตรภาค 
(Interval scale) ขึ้นไป ส่วนตัวแปรอิสระจะมีเพียงตัวเดียวและต้องอยู่ในระดับนามบัญญัติ 
(Nominal scale) ซึ่งจะแบ่งออกเป็น k ระดับ 

ส่วนการทดสอบจะใช้สถิติ F-test ในการทดสอบ ซึ่งลักษณะการตั้งสมมุติฐานจะเป็นดังนี้  
  k3210 ......:H   

  กนัคูแ่ตกต่าง1อย่างนอ้ยคา่:H1   

 สถิติที่ใช้ทดสอบ 

  knและ1kdf
MS
MS

F
w

b   

 สามารถเขียนเป็นตารางวิเคราะห์ความแปรปรวน ได้ดังนี้ 
แหล่งความแปรปรวน SS df MS F 
Between  
Within 

SSb 
SSw 

k-1 
n-k 

MSb 
MSw MSw

MSb
 

Total SSt n-1   
 
 การพิจารณาหากค่าสถิติ F ที่ค านวณได้ไม่มีนัยส าคัญทางสถิติ (Sig >  ) นั่นคือยอมรับ H0 
แสดงว่าค่าเฉลี่ยของกลุ่มไม่มีความแตกต่างกัน ถ้าค่า F ที่ค านวณได้มีนัยส าคัญทางสถิติ (Sig <  ) 
นั่นคือปฏิเสธ H0 ยอมรับ H1 แสดงว่ามีค่าเฉลี่ยอย่างน้อย 1 คู่ที่แตกต่างกัน หากต้องการทราบว่าคู่
ใดบ้างท่ีแตกต่างกันให้ด าเนินการเปรียบเทียบต่อไป ซึ่งก็มีวิธีเปรียบเทียบหลายวิธีดังนี้ 
 1. วิธี Lease significance difference 
 2. วิธี Duncan’s multiple-range test 
 3. วิธี Student-Newman-Keuls test 
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 4. วิธี Turkey’s alternate test 
 5. วิธี Scheffe’s test เป็นต้น 
 
ขั้นตอนการทดสอบ ANOVA 
 
เปิดโปรแกรม SPSS 

Analyze > Compare Means > One-way ANOVA  ดังภาพที่ 33 
 

 
ภาพที่ 33 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

 
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 หลังจากนั้นให้ทาตามขั้นตอน ดังภาพที ่34-36 
 
 
 

 
 

 
 

ภาพที่ 34 
 

 
 
 
 
 
 
 
 
 
 

1.เลือกตวัแปรอิสระและตวัแปรตาม 
2.ช่องส าหรับตวัแปรตามท่ี
ตอ้งการทดสอบ (ขอ้มูลเชิง
ประมาณ) 

3.ตวัแปรอิสระ (ขอ้มูลเชิง
คุณภาพ: 2 กลุ่มขั้นไป) 

4. Click  ปุ่ม Option เพื่อ
ก าหนดค่าสถิติเพ่ิมเติม 

5. ผลท่ีไดจ้ากการ Click 
ปุ่ม option ให ้check ท่ี 
descriptive เพื่อให้
ค  านวณค่าสถิติบรรยาย 
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ภาพที่ 35 

 
 

 
ภาพที่ 36 

 
 
 
 
 
 
 
 
 
 
 
 
 

6. Click ปุ่ม Post Hoc เพื่อเลือกวธีิเปรียบเทียบพหุคูณ (multiple comparison) ซ่ึงสามารถ
เลือกไดห้ลายวธีิ แต่เวลาน าเสนอผลการวเิคราะห์ ใหน้ าเสนอเพียงวธีิเดียว ในท่ีน้ีเลือก 
LSD กบั Scheffe   

8. กดปุ่ม OK 

7. Clickปุ่ม Continue 
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ผลที่ได้จากการใช้ค าสั่ง   One way ANOVA 

 
 
                                        
จากตาราง ANOVA 
 1. ตัวแปร Anxiety : พบว่า ค่า F = .435 sig = .649 (>0.05) ซ่ึงแสดงว่า ครูอาจารย์ที่อยู่
ในโรงเรียนขนาดการต่างกัน  มีความวิตกกังวลในการท างานไม่แตกต่างกัน 
 2. ตัวแปร Eanxiety : พบว่า ค่า F = .723 sig = .488 (>0.05) แสดงว่า ว่า ครูอาจารย์ที่อยู่
ในโรงเรียนขนาดการต่างกัน  มีความวิตกกังวลในเหตุการณ์ไม่แตกต่างหัน  
 ซึ่งถ้าผลการวิเคราะห์ออกมาเช่นนี้ ไม่จ าเป็นต้องไปดู ผลการเปรียบเทียบพหุคูณ เพราะการ
ทดสอบโดยภาพรวมไม่มีคู่ใดแตกต่างกัน 
 แต่ถ้าผลการวิเคราะห์ออกมาว่ามีค่าที่ไม่เท่ากัน 1 คู่ เราต้องการการทดสอบต่อไปว่าคู่ใด
แตกต่างกัน ซึ่งผลออกจะจะได้ดังภาพที่  
 

 

 
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ตัวอย่างท่ี 3 นักเรียนที่ได้รับการอบรมเลี้ยงดูด้วยวิธีการต่างกันจะมีวินัยในตนเองต่างกัน 
จากตัวอย่างที่ 3 มีตัวแปรที่เกี่ยวข้อง 2 ตัว คือ 1) วิธีการอบรมเลี้ยงดู (มีหลายวิธี) 2) วินัย

ในตนเอง (วัดออกมาเป็นตัวเลข) 
 

คนที ่ วิธีการอบรมเลี้ยงดู วินัยในตนเอง 
1 
2 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
20 

1 
2 
3 
1 
2 
3 
1 
2 
3 
1 
2 
3 
1 
2 
3 
1 
2 
3 
1 
2 

4 
1 
4 
5 
1 
5 
5 
1 
5 
3 
5 
4 
1 
3 
5 
5 
1 
5 
1 
1 

 
การตั้งสมมุติฐาน H0     : 1   =   2   =  3  

   H1     : 1      2      3   

หรือ มีค่า  อย่างน้อย 1 คู่ที่ไม่เท่ากัน 

 โดยที่  1 คือ ค่าเฉลี่ยของวินัยในตนเองของนักเรียนที่ได้รับการอบรมเลี้ยงดูด้วยวิธีที่ 1 

  2 คือ ค่าเฉลี่ยของวินัยในตนเองของนักเรียนที่ได้รับการอบรมเลี้ยงดูด้วยวิธีที่ 2 
3คือ ค่าเฉลี่ยของวินัยในตนเองของนักเรียนที่ได้รับการอบรมเลี้ยงดูด้วยวิธีที่ 3 

 สถิติที่จะใช้ในการทดสอบ คือ ANOVA 
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ขั้นตอนการวิเคราะห์ 
 เปิดโปรแกรม Spss จะได้ภาพที ่37 

 
ภาพที่ 37 

 
 

 ท าการก าหนดชื่อตัวแปรและลงรหัสข้อมูล (ตามขั้นตอนข้างต้น) จะได้ภาพที ่38 
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ภาพที่ 38 
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คลิก Analyze > Compare Means > One-way ANOVA  ดังภาพที ่39 

 
ภาพที่ 39 

 

จะได้หน้าจอดังภาพที่ 40 ท าการใส่ตัวแปรที่ต้องการวิเคราะห์  
 ในช่อง Dependent Variable เลือกตัวแปร discip 
 ในช่อง Factor เลือกตัวแปร care 

 
ภาพที่ 40 

 
ถ้าต้องการแสดงสถิติพ้ืนฐานคลิกที่  แล้วคลิกท่ี Descriptive ดังภาพที่ 41 
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 ภาพที่ 41 

 
 ถ้าต้องการเปรียบเทียบคู่ที่แตกต่างกันให้คลิก  แล้วคลิกท่ีวิธี LSD ดังภาพที ่42 

 
ภาพที่ 42 

 
 แล้วกด OK  ผลการวิเคราะห์ดังนี้ 
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Oneway 
 

Descriptives

DISCIP

7 3.4286 1.8127 .6851 1.7521 5.1050 1.00 5.00

7 1.8571 1.5736 .5948 .4018 3.3125 1.00 5.00

6 4.6667 .5164 .2108 4.1247 5.2086 4.00 5.00

20 3.2500 1.8028 .4031 2.4063 4.0937 1.00 5.00

1.00

2.00

3.00

Total

N Mean

Std.

Dev iation Std.  Error

Lower

Bound

Upper

Bound

95% Conf idence

Interv al for Mean

Minimum Maximum

 
 

จากตารางแสดงค่าสถิติพ้ืนฐาน (ค่าเฉลี่ย และค่าเบี่ยงเบนมาตรฐาน) พบว่า ค่าเฉลี่ยวินัยใน
ตนเองของนักเรียนที่เลี้ยงดูตามวิธีที่ 1 มีค่า 3.42 ส่วนวิธีที่ 2 มีวินัยในตนเองเฉลี่ย 1.85 และวิธีที่ 3 
มีค่าเฉลี่ย 4.66 
 

ANOVA

DISCIP

25.845 2 12.923 6.119 .010

35.905 17 2.112

61.750 19

Between Groups

Within Groups

Total

Sum of

Squares df

Mean

Square F Sig.

 
 
จากตารางเป็นตาราง ANOVA  
 เป็นการทดสอบสมมุติฐานว่า H0     : 1   =   2   =  3  

    H1     : 1      2      3   

หรือ มีค่า  อย่างน้อย 1 คู่ที่ไม่เท่ากัน 

พบว่า ค่า F = 6.119 sig = 0.010 (< 0.05) หมายความว่า ปฏิเศษ H0 ยอมรับ H1 ซึ่ง
แสดงว่า H1     : 1      2      3  หรือ มีค่า  อย่างน้อย 1 คู่ที่ไม่เท่ากัน ดังนั้นสรุปได้

ว่าวิธีการเลี้ยงดูที่ต่างวิธีกันท าให้นักเรียนมีวินัยในตนเองแตกต่างกัน 
 เมื่อเราพบว่าวิธีการเลี้ยงดูที่ต่างกันท าให้วินัยในตนเองของนักเรียนต่างกันก็จะต้องดูต่อไปว่า
แล้ววิธีการเลี้ยงดูคู่ไหนที่แตกต่างกันจาก Post Hoc Tests 
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Post Hoc Tests 
 

Multiple Comparisons

Dependent  Variable: DISCIP

LSD

1.5714 .7768 .059 -6.75E-02 3.2104

-1.2381 .8085 .144 -2.9440 .4678

-1.5714 .7768 .059 -3.2104 6.751E-02

-2.8095* .8085 .003 -4.5154 -1.1037

1.2381 .8085 .144 -.4678 2.9440

2.8095* .8085 .003 1.1037 4.5154

(J) CARE

2.00

3.00

1.00

3.00

1.00

2.00

(I) CARE

1.00

2.00

3.00

Mean

Dif f erence

(I-J) Std.  Error Sig.

Lower

Bound

Upper

Bound

95% Conf idence

Interv al

The mean dif f erence is signif icant at the .05 lev el.*. 

 
 

จากตารางเป็นตารางแสดงการเปรียบเทียบความแตกต่างรายคู่โดยวิธี LSD 
 โดยมีสมมุติฐานดังนี้ ji0 :H   
    ji1 :H   

 วิธีที่ 1 กับวิธีที่ 2 พบว่า sig = 0.059 (> 0.05) จะยอมรับ H0 ซึ่งแสดงว่า วิธีการเลี้ยงดูวิธีที่ 
1 และวิธีที่ 2 ท าให้นักเรียนมีวินัยในตนเองไมแ่ตกต่างกัน (เท่ากัน) 
 วิธีที่ 1 กับวิธีที่ 3 พบว่า sig = 0.144 (> 0.05) จะยอมรับ H0 ซึ่งแสดงว่า วิธีการเลี้ยงดูวิธีที่ 
1 และวิธีที่ 3 ท าให้นักเรียนมีวินัยในตนเองไม่แตกต่างกัน (เท่ากัน) 

วิธีที่ 2 กับวิธีที่ 3 พบว่า sig = 0.003 (< 0.05) จะปฏิเศษ H0 ยอมรับ H1 ซึ่งแสดงว่า 
วิธีการเลี้ยงดูวิธีที่ 2 และวิธีที่ 3 ท าให้นักเรียนมีวินัยในตนเองแตกต่างกัน 
 
การน่าเสนอผลการวิเคราะห์ด้วย One-way ANOVA 
ตาราง 5  แสดงการวิเคราะห์ความแปรปรวนของความมีวินัยในตนเองของนักเรียนระหว่าง
วิธีการเลี้ยงดู 
แหล่งความแปรปรวน SS df MS F Sig. 
ระหว่างกลุ่ม 
ภายในกลุ่ม 

25.845 
35.905 

2 
17 

12.923 
2.112 

6.119* 0.010 

รวม 61.750 19    
* P<0.05 
 จากการวิเคราะห์คะแนนความมีวินัยในตนเองของนักเรียนระหว่างวิธีการเลี้ยงดู  พบว่า 
วิธีการเลี้ยงดูที่ต่างกันท าให้วินัยในตนเองของนักเรียนต่างกันอย่างมีนัยส าคัญทางสถิติที่ 0.05 ซึ่ง
จะต้องมีการทดสองรายคู่ต่อไปดังแสดงผลในตารางที่  
 
ตาราง 6  แสดงการเปรียบเทียบค่าเฉลี่ยของความพึงพอใจในการท่างานของพนักงานในฝ่าย
ต่างๆ 
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วิธีการเลี้ยงดู ค่าเฉลี่ย วิธีการเลี้ยงดู 
1 2 3 

1 3.42    
2 1.85   * 
3 4.66    
* P<0.05 

จากการเปรียบเทียบรายคู่ พบว่า ค่าเฉลี่ยของความมีวินัยในตนเองของนักเรียนวิธีการเลี้ยงดู
วิธีที่ 2 แตกต่างกับวิธีที่ 3 อย่างมีนยัส าคัญทางสถิติที่ 0.05 

 
 

การวิเคราะห์ค่าสหสัมพันธ์เพียร์สัน (Pearson Product Moment Correlation) 
การวิเคราะห์ค่าสหสัมพันธ์เพียร์สันเป็นการวิเคราะห์เพ่ือหาความสัมพันธ์ระหว่างตัวแปร 

โดยทั้งสองตัวแปรจะต้องมีระดับการวัดตั้งแต่อันตรภาคขึ้นไป เช่น 
 ความสัมพันธ์ของคะแนนการสอบวิชาคอมพิวเตอร์ (X) กับวิชาสถิติ (Y) ของ

นักศึกษา 
 ความสัมพันธ์ของความสูง (X) กับน้ าหนัก (Y) ของนักเรียน 
 ความสัมพันธ์ของราคาส่งออก (X)  กับปริมาณส่งออก (Y) ของล าไย 

 ความสัมพันธ์ของตัวแปร 2 ตัว X และ Y อาจจะมีความสัมพันธ์อยู่ในรูปแบบต่างๆ เช่น 
ความสัมพันธ์ที่มีลักษณะแนวโน้มเป็นเส้นตรง หรือเส้นโค้งพาราโบลา หรือแบบอื่นๆ ก็ได้ แต่ในที่นี้จะ
กล่าวถึงเฉพาะความสัมพันธ์ที่มีลักษณะแนวโน้มเป็นเส้นตรง ซึ่งแบ่งออกเป็น 2 แบบ คือ 
 1. ความสัมพันธ์เชิงบวก (positive Correlation) เป็นความสัมพันธ์ ที่เรียกว่า แปรผันตาม
กัน กล่าวคือ ถ้า X มีค่ามากขึ้น ค่าของ Y ก็จะมีแนวโน้มมากขึ้นด้วย แต่ถ้า X มีค่าน้อยลง ค่าของ Y 
ก็จะมีแนวโน้มน้อยลงด้วย 
 2. ความสัมพันธ์เชิงลบ (negative Correlation) เป็นความสัมพันธ์ ที่เรียกว่า แปรผัน
กลับกัน หรือแปรผกผัน กล่าวคือ ถ้า X มีค่ามากขึ้น ค่าของ Y ก็จะมีแนวโน้มลดลง แต่ถ้า X มีค่า
น้อยลง ค่าของ Y ก็จะมีแนวโน้มเพ่ิมขึ้นด้วย 
 
 
      X     
                                        0         
0         
   0   0                   
                                0  0   0 
                       0    0  0 
                  0    0 
               0    Y 
 

     ความสัมพันธ์เชิงบวก 

 
    X     
 0 0 
                 0    0                                           
        0 0 0             
                             0  0 0    
                                0   0  0 
                                         0   0                 
Y 
 
                    ความสัมพันธ์เชิงลบ 
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 การพิจารณาความสัมพันธ์เชิงเส้นตรงของ X และ Y ว่ามีความสัมพันธ์มากน้อยเพียงใด
สามารถค านวณความสัมพันธ์นั้นออกมาเป็นค่าของตัวเลข ในที่นี้จะกล่าวถึงวิธีการของเพียร์สัน ที่
เรียกว่า สัมประสิทธิ์สหสัมพันธ์ (Correlation Coefficient) ซึ่งมีสูตรในการค านวณคือ 
 ถ้าสมมุติให้ r แทน สัมประสิทธิ์สหสัมพันธ์ ของข้อมูลตัวแปรคู่ X และ Y ดังนั้นจะได้ว่า 

 


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หรือ 
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หรือ 

  

    
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โดยสัมประสิทธิ์สหสัมพันธ์ (r) จะมีค่าอยู่ระหว่าง -1 ถึง 1 
ถ้า r = 1 หมายความว่า ตัวแปร X และ Y มีความสัมพันธ์เชิงบวกแบบตามกันโดยสมบูรณ์ 
ถ้า r = 0 หมายความว่า ตัวแปร X และ Y ไม่มีความสัมพันธ์เชิงเส้นตรง 
ถ้า r = -1 หมายความว่า ตัวแปร X และ Y มีความสัมพันธ์เชิงลบกันโดยสมบูรณ์ 
 
 การทดสอบสมมุติฐานเกี่ยวกับค่าความสัมพันธ์ (สมประสิทธิ์สหสัมพันธ์) 

ลักษณะการตั้งสมมุติฐาน H0     :     =   0 (ไม่มีความสัมพันธ์กัน) 
H1      :         0 (มีความสัมพันธ์กัน)  หรือ 
H0     :     =   0 (ไม่มีความสัมพันธ์กัน) 
H1      :     >   0 (มีความสัมพันธ์กันทางบวก) หรือ 
H0     :     =   0 (ไม่มีความสัมพันธ์กัน) 
H1      :     <   0 (มีความสัมพันธ์กันทางลบ) 
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สถิติที่ใช้ทดสอบ 

2n
)r1(

r
t

2




   2ndf   

 
การพิจารณาหากค่าสถิติ t ที่ค านวณได้ไม่มีนัยส าคัญทางสถิติ (Sig >  ) นั่นคือยอมรับ H0 

แสดงว่าไม่มีความสัมพันธ์กันระหว่างตัวแปร แต่ถ้าค่า t ที่ค านวณได้มีนัยส าคัญทางสถิติ      (Sig < 
 ) นั่นคือปฏิเสธ H0 ยอมรับ H1 แสดงว่ามีความสัมพันธ์กันระหว่างตัวแปร (สัมพันธ์ทางบวก หรือ
สัมพันธ์ทางลบ) 

 
ขั้นตอนการทดสอบค่าสหสัมพันธ์ 
 
เปิดโปรแกรม SPSS 

คลิก Analyze > Correlate > Bivariate ดังภาพที่ 43 

 
ภาพที ่43 
 
จะได้ดังรูปที่ 44 



  

 

61 

 
ภาพที่ 44 

 
ให้เลือกตัวแปรที่เราต้องการหาความสัมพันธ์ในชอง  มาไว้ในช่อง  ในทีนี้ให้ท่านเลือก

ตัวแปร eanxiety  anxiety  stress  หลังจากนั้นให้ Click ที่ ปุ่ม OK ดังภาพที่ 45 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

 

  Correlation Coefficients  หมายถึง ค่าสหสัมพนัธ์ท่ีเราตอ้งปารวเิคราะห์ โดยปกติ
โปรแกรมจะเลือก ค่าสหสัมพนัธ์ของเพียร์สัน 
     Test of Significant หมายถึง เลือกวา่จะทดสอบนยัส าคญัทาสถิติเป็นแบบ หางเดียว (One 
tailed)  หรือ สองหาง (Two tailed) 
   Flag Siginficant Correlations หมายถึง ใหแ้สดงดอกจนั (*) ท่ีค่าสหสัมพนัธ์ท่ีมีนยัส าคญัทาง
สถิติ 
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ภาพที ่ 45 
 

ผลการวิเคราะห์ จากการประมวลผล ดังนี้ 
 

 
 Pearson Correlation หมายถึง ค่าสหสัมพันธ์เพียร์สัน 
 ระดับนัยส าคัญทางสถิติ (sig) ถ้ามีค่า sig น้อยกว่าหรือเท่ากับ .05 แสดงว่าค่า

สหสัมพันธ์นั้นมีนัยส าคัญทางสถิติ แต่ถ้า sig มากกว่า .05 ค่าสหสัมพันธ์นั้นไม่มีนัยส าคัญทางสถิติ 
 N หมายถึง จ ากลุ่มตัวอย่างที่เข้ากระบวนการวิเคราะห์ 

 
ผลการวิเคราะห์คาสหสัมพันธ์พบว่า   
ตัวแปร EANXIRTY มีความสัมพันธ์ทางบวกกับตัวแปร ANXIETY อย่างมีนัยส าคัญทางสถิติที่

ระดับ .05 (sig <0.05) โดยมีค่าสหสัมพันธ์เพียร์สันเท่ากับ .269    
ตัวแปร EANXIRTY ไม่มีความสัมพันธ์กับตัวแปร stress (r= .047,sig >0.05) หรือมี

ความสัมพันธ์กันอย่างไม่มีนัยส าคัญทางสถิติ   

Click  

   
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 ANXIETY ไม่มีความสัมพันธ์กับตัวแปร STRESS (r= .086, sig >0.05) หรือมีความสัมพันธ์
กันอย่างไม่มีนัยส าคัญทางสถิติ 
 

ตัวอย่างท่ี 4 ความถนัดทางการเรียนมีความสัมพันธ์ทางบวกกับผลสัมฤทธิ์ทางการเรียน 
 จากตัวอย่างที่ 4 มีตัวแปรที่เกี่ยวข้อง 2 ตัว คือ 1) ความถนัดทางการเรียน (วัดออกมาเป็น
ตัวเลข) และ  2) ผลสัมฤทธิ์ทางการเรียน (วัดออกมาเป็นตัวเลข) 
  
ความถนัดทางการเรียน ผลสัมฤทธิ์ทางการเรียน 
84.00 
45.00 
76.00 
98.00 
85.00 
86.00 
69.00 
63.00 
73.00 
79.00 
74.00 
58.00 
75.00 
95.00 
86.00 
62.00 
53.00 
83.00 
71.00 
94.00 

85.00 
52.00 
65.00 
85.00 
75.00 
63.00 
56.00 
58.00 
78.00 
96.00 
85.00 
84.00 
69.00 
88.00 
96.00 
68.00 
45.00 
75.00 
85.00 
63.00 

 
การตั้งสมมุติฐาน H0     :     =   0 

H1      :     >   0 
 โดยที่   คือ ความสัมพันธ์ระหว่างความถนัดทางการเรียนกับผลสัมฤทธิ์ทางการเรียน 
 สถิติที่จะใช้ในการทดสอบ คือ ค่าสหสัมพันธ์แบบเพียร์สัน 
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ขั้นตอนการวิเคราะห์ 
 เปิดโปรแกรม Spss จะได้ภาพที่ 46 

 
ภาพที่ 46 
 

 ท าการก าหนดชื่อตัวแปรและลงรหัสข้อมูล (ตามขั้นตอนข้างต้น) ดังภาพที่ 47 
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ภาพที่ 47 
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คลิก Analyze > Correlate > Bivariate ดังภาพที ่48 

 
ภาพที่ 48 

 
จะได้หน้าจอดังภาพที่ 49 ท าการใส่ตัวแปรที่ต้องการวิเคราะห์  
 ในช่อง Variable เลือกตัวแปร skill และ ach (หาความสัมพันธ์ของ 2 ตัวนี้) แล้วคลิก OK 

 
ภาพที่ 49 
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ผลการวิเคราะห์จะได้ดังนี้  
 
Correlations 
 

Correlations

1.000 .530*

. .016

20 20

.530* 1.000

.016 .

20 20

Pearson Correlation

Sig. (2-tailed)

N

Pearson Correlation

Sig. (2-tailed)

N

SKILL

ACH

SKILL ACH

Correlation is signif icant at the 0.05 level (2-tailed).*. 

 
 
จากตารางเป็นการการทดสอบค่าสหสัมพันธ์ 

เป็นการทดสอบสมมุติฐาน H0     :     =   0 
H1      :     >   0 

พบว่า ค่า sig = 0.016 (<0.05) หมายความว่า ปฏิเศษ H0 ยอมรับ H1 ซึ่งแสดงว่า                
H1      :     >   0 ดังนั้นสรุปได้ว่าความถนัดทางการเรียนมีความสัมพันธ์ทางบวกกับผลสัมฤทธิ์
ทางการเรียน โดยมีความสัมพันธ์กัน 0.530 
 
การน่าเสนอผลการทดสอบนัยส่าคัญค่าสัมประสิทธิ์สหสัมพันธ์ 
ตาราง 7  แสดงการทดสอบความสัมพันธ์ระหว่างความถนัดทางการเรียนกับผลสัมฤทธิ์ทางการ
เรียน 
ความสัมพันธ์ระหว่าง ค่าสัมประสิทธิ์สหสัมพันธ์ 
ความถนัดทางการเรียนกับผลสัมฤทธิ์ทางการเรียน 0.53* 
* P<0.05 
 จากการทดสอบพบว่า ความถนัดทางการเรียนมีความสัมพันธ์ทางบวกกับผลสัมฤทธิ์ทางการ
เรียน อย่างมีนัยส าคัญทางสถิติที่ 0.05 และมีความสัมพันธ์กันสูงถึง 53% 
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การวิเคราะห์ ไคสแควร์ (Chi - Square) 
 
การทดสอบ ไค-สแควร์  มีการทดสอบ 2 กรณีคือ 

1. กรณีตัวแปรเดียว  เป็นการทดสอบเพ่ือดูว่าความถี่ที่สังเกตได้แตกต่างจากความที่
ที่คาดหวังหรือไม่ หรือ อาจกล่าวได้ว่าจ านวน  ความถี่หรือสัดส่วนที่ปรากฏในแต่
ละกลุ่มนั้นแตกต่างกันหรือไม่ 

2. กรณี 2 ตัวแปร เป็นการทดสอบความสัมพันธ์ระหว่างตัวแปรสองตัวที่ข้อมูลอยู่ใน
รูปจ านวน ความถี่ หรือร้อยละ 

 
ขั้นตอนการวิเคราะห์ 

 กรณีตัวแปรเดียว 
Analyze > Nonparametric > Chi-Square 

สมมติฐานการวิจัย 
 จ านวนครูอาจารย์มีระดับความวิตกกังวลในสถานการณ์แตกต่างกัน 
 

 
 

ภาพประกอบ 50 
 
 
 
 
 

 

 
 
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ผลการใช้ค าสั่ง 
 

 
 

ภาพประกอบ 51 
 
      Test  Variable List  หมายถึงตัวแปรที่เราต้องการทดสอบ สามารถเลือกได้ 1 ตัว  ตัวแปรที่
ใช้ 

ควรเป็นตัวแปรชนิด category เช่น เพศ  อาชีพ ศาสนา หรือตัวที่มีข้อมูลเป็นจ านวนหรือ
ความถี่  ในที่นี้เลือกตัวแปร e1 ซึ่งเป็นข้อค าถามเกี่ยวกับความวิตกกังวลในสถานการณ์ของ
ครูอาจารย์ โดยมีระดับความวิตกกังวลตั้งแต่น้อยที่สุด (1) จนถึงมากที่สุด (5) โดยข้อมูลที่ได้
ในแต่ละระดับจะเป็นความถี ่

       Expect Range หมายถึง เป็นการระบุช่วงของค่าตัวแปรที่ต้องการวิเคราะห์ สามารถเลือก
ได้ทางใดทางหนึ่ง 

Get  from data   หมายถึง จะวิเคราะห์ทุกค่าของตัวแปร เช่น อาชีพ มี 5 อาชีพ ก็จะน า 
ตัวแปรอาชีพ ที่มีค่าท้ัง 5 มาวิเคราะห์ ในกรณีนี้น าตัวแปร e1 มาวิเคราะห์
ซึ่งมีท้ังหมด 5 ระดบั 

Use  Specific range หมายถึง เลือกค่าบางค่าของตัวแปรมาวิเคราะห์ ซึ่งต้องระบุค่าต่ าสุด
และสูงสุดของตัวแปร เช่น อาชีพ ก าหนดค่าต่ าสุด (Lower) มีค่าเป็น 1 
และค่าสูงสุด(Uper) มีค่าเป็น 3 หมายถึงน าเฉพาะ 3 อาชีพแรกเท่านั้นมา
วิเคราะห์ 

      Expected Value   เป็นการระบุค่าที่คาดหวัง (E) ของแต่ละค่าตัวแปร หรือระบุค่าสัดส่วน
ของแต่ละค่าของตัวแปร โดยมีทางเลือก 2 ทาง คือ 

All  Categories equal หมายถึง ต้องการทดสอบว่าจ านวน ความถี่หรือสัดส่วนของระดับ
ต่างของตัวแปร ในแต่ละกลุ่มเท่ากันหรือไม่ 

 

 

  
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Value    หมายถึง ต้องการทดสอบว่าสัดส่วนของแต่ละระดับหรือกลุ่มเป็นไปตามท่ีคาดไว้ 
หรือไม่ โดยต้องระบุสัดส่วน จ านวน หรือความถ่ีลงไปในแต่ระดับหรือกลุ่ม โดย 
ก าหนดทีละค่าของแต่ระละดับหรือกลุ่ม แล้ว Click ที่ปุ่ม Add 

 ในที่นี้จะเป็นการทดสอบ ตัวแปร e1 โดยใช้ All categories equal  ซึ่งเป็นการทดสอบว่า
จ านวนของครูอาจารย์ในแต่ละระดับเท่ากันหรือไม่  เมื่อก าหนดค่าต่างเสร็จแล้ว ให้ Click ที่ ปุ่ม OK 
ผลที่ได้ดังปรากฏดังนี้ 

 
 

 ตาราง แสดงความถ่ี โดย 
Observed N  หมายถึง จ านวนความถี่จากการสังเกต(O) หรือความถี่ที่ได้จากการเก็บ
รวบรวมข้อมูล 
Expectd N    หมายถึง  ความถี่คาดหวัง (E)  ซึ่งในที่นี้ในแต่ละระดับมีค่าเท่ากันหมด
คือ 18 คน 
Residual      หมายถึง  ผลต่างระหว่างความถ่ีจาการสังเกตกับความถี่คาดหวัง (O -E) 

ผลการวิเคราะห์  
 Chi – square   หมายถึง ค่าสถิติไคสแควร์ ซึ่งพบว่ามีค่าเท่ากับ 23.333 
 df   หมายถึง ค่าองศาอิสระ มาจาก K-1 (จ านวนกลุ่มหรือระดับลบด้วยหนึ่ง) 
 Asymp.Sig  หมายถึงระดับนัยส าคัญทางสถิติ ของค่าไคสแควร์ (23.33) ซึ่ง

พบว่ามีค่าต่ ากว่า .05  (Sig = .000)  จึงปฏิเสธ H0   :  จวนของครูอาจารย์ในแต่ละระดับมีค่าเท่ากัน 
และยอมรับ H1 : จ านวนครูอาจารย์ในแต่ละระดับแตกต่างกัน  
 ผลการทดสอบสมมติฐาน สรุปได้ว่า จ านวนครูอาจารย์ในละระดับ(กลุ่ม)แตกต่างกันอย่างมี
นัยส าคัญทางสถิติที่ระดับ .01 
 
 

 

 
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การทดสอบกรณี 2 ตัวแปร 
  เป็นการทดสอบเพ่ือดูว่าตัวแปรสองตัวมีความสัมพันธ์กันหรือไม่ 
 
ขั้นตอนการทดสอบ 

Analyze > Descriptive Statistics > Crosstabs 
 

 
 

ภาพประกอบ  52 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



  

 

72 

 
ผลที่ได้จาการใช้ค าสั่ง ดังภาพประกอบ 53 
 

 
 

ภาพประกอบ  53 
 

  ตัวแปรที่มีอยู่ทั้งหมดใน File ข้อมูล 
 Row หมายถึง ตัวแปรที่เราต้องการทดสอบหาความสัมพันธ์ แต่ก าหนดให้เป็นส่วนแถวของ
ตารางผลการวิเคราะห์ 
Colums หมายถึง ตัวแปรที่เราต้องการทดสอบหาความสัมพันธ์ แต่ก าหนดให้เป็นส่วนColumn
ของตารางผลการวิเคราะห์ 

ในภาพประกอบ 53 นี้ผู้วิจัยสนใจที่จะทดสอบความสัมพันธ์ระหว่างเพศกับความวิตกกังวล
ในสถานการณ์ (Geanxie) ซึ่งเดิมตัวแปรนี้มีการ Recode ให้มีข้อมูลเป็นความความถี่ ซึ่งจะท าให้ตัว
แปรเป็นตัวแปรชนิด Category โดยก าหนดให้เพศ อยู่ใน Row(s) และ geanxie อยู่ที่ Column(s) 
หลังจากนั้น ให้ Click ที่  ปุ่ม Statistics... ได้จะปรากกฎดังภาพประกอบ  54 

 

 

 

 

 
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ภาพประกอบ 54 
 
จากภาพประกอบ 54  ให้ check ที่ Chi-square และ Click ที่ Continue  จะได้ผลกลับไป

เหมือนภาพประกอบ 53 แล้ว Click ที่  ปุ่ม  Cells...  จะปรากฏผลดังภาพประกอบ 55 

 
 

     ภาพประกอบ 55 
 

 จากภาพประกอบ 55 ให้ Check ที่ Observed และ Expected เพ่ือให้แสดงค่าที่สังเกตได้
กับค่าคาดหวัง แต่ถ้าต้องการให้แสดงค่าร้อยละด้วยให้ Check ที่ กลุ่ม Percentage  หลังจากนั้นให้ 
Click ที่ Continue 
 

 

 
 
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ผลการวิเคราะห ์

 
 
 เป็นการแสดงค่าความถี่ที่ได้จากสังเกต()และค่าความถี่ที่คาดหวัง() จ าแนกตามกลุ่ม
ของตัวแปรทั้งสองตัวแปร  

 
 
 เป็นผลการวิเคราะห์ ค่าไคสแควร์ (ดู Pearson Chi-Square) พบว่า มีค่าเท่ากับ 19.469 , 
df = 4 sig = .001 แสดงว่า ตัวแปรเพศและความวิตกกังวลมีความสัมพันธ์กันอย่างมีนัยส าคัญทาง
สถิติที่ระดับ .001 หรือกล่าวได้ว่า ความวิตกกังวลใสถานการณ์ขึ้นอยู่กับเพศ 
 
 
 
แหล่งข้อมูล อ้างอิงจาก: www.crc.ac.th/online/75106/20091117092414.doc 

  


